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お客様へのご注意

ソリッドステート機器はエレクトロメカニカル機器とは動作特性が異なります。さらにソリッドステート機器は
いろいろな用途に使われることからも、この機器の取扱責任者はその使用目的が適切であるかどうかを充分確認
してください。
この機器の使用によって何らかの損害が生じても当社は一切責任を負いません。詳しくは、パブリケーション・
ナンバー SGI-1.1『ソリッド・ステート・コントロール　安全ガイドライン』を参照してください。
本書で示す図表やプログラム例は本文を容易に理解できるように用意されているものであり、その結果としての
動作を保証するものではありません。個々の用途については数値や条件が変わってくることが多いため、当社で
は図表などで示したアプリケーションを実際の作業で使用した場合の結果については責任を負いません。
本書に記載されている情報、回路、機器、装置、ソフトウェアの利用に関して特許上の問題が生じても、当社は
一切責任を負いません。
当社の事前の文書による承諾なしに、本ソフトウェアおよび本書の一部または全部を複製することを禁じます。
製品改良のため、仕様などを予告なく変更することがあります。
本書を通じて、特定の状況下で起こりうる人体または装置の損傷に対する警告および注意を示します。

注意： 本書内の「注意」は正しい手順を行なわない場合に、人体に障害を加えうる事項、および装置の損傷ま
たは経済的な損害を生じうる事項を示します。

これらの項目により以下の説明を行ないます。
・ トラブルが起こりうる場合
・ トラブルの原因
・ 不適当な操作を行なった場合の結果
・ トラブルの回避方法

重要： ソフトウェアをご利用の場合は、データの消失が考えられますので、適当な媒体にアプリケーションプ
ログラムのバックアップをとることをお奨めします。

重要： 本製品を日本国外に輸出する際、日本国政府の許可が必要な場合がありますので、事前に当社までご相
談ください。

本版は、9399-SQLGR-May, 1998の和訳です。9399-SQLGRを正文といたします。
＠ 1998 Rockwell Software Inc. All rights reserved. Printed in the United States of America

WINtelligentシリーズは Rockwell Software Inc.の登録商標です。また、以下のものは Rockwell Software Inc.の商標
です。Rockwell Softwareのロゴ、RSAlarm, RSAnimator, RSAssistant, RSBatch, RSBreakerBox, RSButton, RSChart, 
RSCompare, RSControlRoom, RSData, RSDataPlayer, RSEventMaster, RSGuage, RSJunctionBox, RSLogix Emulate 5, 
RSLogix Emulate 500, RSGuardian, RSHarmony, RSKeys, RSLadder, RSLadder 5, RSLadder 500, RSLibrary Manager, 
RSLinx, RSLogix 5, RSLogix 500, RSLogix Frameworks, RSMailman, RSNetworx for ControlNet, RSNetworx for 
DeviceNet, RSPortal, RSPower, RSPowerCFG, RSPowerRUN, RSPowerTools, RSRules, RSServer32, RSServer, RSServer 
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はじめに

本書の目的本書の目的本書の目的本書の目的
RSSqlソフトウェアのドキュメンテーションセットは、Getting 

Resultsマニュアルとオンライン・ヘルプ・システムから構成されま

す。ドキュメンテーションセットは、ソフトウェアに標準装備され

ており、ユーザは製品に関する情報を簡単に参照することができま

す。 ドキュメンテーションセットには必要な情報のみが記載されて

いるため、ユーザは大量の紙のマニュアルから解放されます。

本書は、RSSqlソフトウェアの入門書です。本書では、RSSqlソフ

トウェアをインストールして使用する方法、およびこのソフトウェ

アを有効に利用する方法について説明します。また、オンライン・

ヘルプ・システムの使用方法についても説明します。

オンライン・ヘルプ・システムには、ソフトウェアの概要、機能の

実行手順、画面の内容、および参照情報がすべて記載されていま

す。ヘルプには、概要のトピック、クイック・スタート・トピッ

ク、ステップ・バイ・ステップ・プロシージャ、およびスクリーン

エレメント (テキストボックス、ドロップダウンリスト、オプション

ボタンなど )という 4つの基本コンポーネントがあります。すべて

のヘルプは、アプリケーションの内容に対応しているため、ユーザ

は機能の実行方法や制御の内容に関する説明を迅速に参照すること

ができます。

対象とするユーザ対象とするユーザ対象とするユーザ対象とするユーザ
本書は、以下に精通する制御システムのエンジニアまたはデータ

ベース管理者を対象としています。

� IBM互換のパーソナルコンピュータ

� Microsoft Windows NTオペレーティングシステム

� Microsoftの動的データ交換 (DDE)

� ロックウェル・ソフトウェアの PLCプログラミングツール

� オープン・データベース・コネクティビティ (ODBC)
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� Oracle Callable Interface(OCI)

本書の表記規則本書の表記規則本書の表記規則本書の表記規則
本書の表記規則は、Microsoft Corporationが推奨する表記規則に従ってい

ます。Microsoft Windowsのユーザインターフェイスを初めて使用する場

合、RSSqlソフトウェアを使用する前に、Microsoft Windowsのマニュア

ルを読むことをお奨めします。

本書に対するご意見本書に対するご意見本書に対するご意見本書に対するご意見
本書の間違いをご指摘いただく場合、および今後のリリースに対するご

希望をお知らせいただく場合、ソフトウェアに添付された用紙をご使用

ください。
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Chapter

RSSqlの概要の概要の概要の概要

RSSqlソフトウェアは、Windows NT™ベースのプログラムです。このソ

フトウェアを使用すると、制御システムのエンジニアおよびデータベー

ス管理者は、プログラムを 1行も作成せずに、プロセス制御システムと

情報管理システムのデータをやり取りすることができます。

RSSqlトランザクションビルダというグラフィカル・ユーザ・インター

フェイス (GUI)により、プラントフロアの機器データを企業全体のリ

レーショナルデータベースに結び付けるトランザクションを作成して、

表の数値やストアドプロシージャの引数に使用することができます。ま

た、複数の RSSqlをWindows NTのサービスとして使用することにより、

システム間でデータを移動することができます。

RSSql の特徴および利点RSSql の特徴および利点RSSql の特徴および利点RSSql の特徴および利点
RSSqlソフトウェアには、他の産業用トランザクションシステムには見ら

れない特徴および利点がいくつかあります。以下にその例を示します。

� 分散アーキテクチャにより、スタンドアロンの PCまたは企業ネット

ワーク上の複数の PCで、NTのサービスを利用することができます。

いずれの場合も、構成ファイルが一括管理されるため、RSSqlの構成

および操作が統一化されます。

� アプリケーションレベルの ACK/NAKに加えて、RSSql NTサービス間で

リカバリ機能付きのフルロギングを装備しています。

� DDEコントロールコネクションにより、DDEアイテム名またはタグ名

によって DDEデータポイントを定義することができます。RSSqlソフ

トウェアには、AIシリーズや RSLogix500プログラミング言語などに

より生成されるタグ・シンボル・ファイルとの統合リンクが装備され

ています。タグ名および DDEアイテムの関係は、実行時に解析されま

す。
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� RSView32コントロールコネクションは、RSView32との相互動作性を

提供します。RSView32コントロールコネクションにより、RSView32

プロジェクトのタグから RSSqlのデータポイントを作成することがで

きます。実行時にタグが解析されるため、RSView32プロジェクトで行

なった変更は RSSqlの構成に表示されます。

� PLCデータテーブルの連続する複数のレジスタをRSSqlのデータポイン

トにマップすることができます。これにより、ASCIIレジスタのブ

ロックを読取り、これらを 1つの文字列としてデータベースに渡すこ

とができます。必要であれば、Parse()機能により演算式を作成して、

レジスタを元のタイプに変換してからデータベースに渡すこともでき

ます。

� Windowsベースのポイント・アンド・クリック・インターフェイスに

より、強力なトランザクションを迅速に作成することができます。ト

ランザクションは、プラントフロアの機器データを収集して、必要に

応じてデータを操作して、リレーショナルデータベースにデータを送

信します。

� 様々な方法でトランザクションを起動することができます。トランザ

クションは、組込みの定期イベントにより起動するだけでなく、外部

制御システムのイベントや、C言語の関数呼出しにより Visual Basicな

どの外部アプリケーションからも起動することができます。不定期イ

ベントの場合、制御ポイントの値が一定の値を上回ったり、下回った

り、値が変化した際に、トランザクションを起動するかどうかを選択

することができます。また、制御ポイントの値がゼロでなければトラ

ンザクションを起動して、値がゼロにリセットされるとトリガを停止

するように、スキャンレートを指定することもできます。

� 2つの組込み定期イベント (system startupおよび system shutdown)により、

トランザクションの起動を制御することができます。また、RSSqlイ

ベントスケジューラにより、定期イベントのライブラリを作成するこ

とができます。
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� RSSqlトランザクションマネージャは、双方向のトランザクションをサ

ポートしています。トランザクションマネージャは、制御システムか

らデータベースにデータを移動するだけでなく、データの移動が正常

に終了すると、肯定応答によりメッセージベースのリンクを提供しま

す。この方法を使用すると、イベントトランザクションのデータ統合

性が最適化される、トランザクションビューに表示される数値の精度

が向上する、データが実際にデータベースに渡されたかどうかを制御

システムが検証したい場合にアプリケーションの待ち時間が低下する、

などの利点があります。

� RSSqlトランザクションマネージャは、ストアドプロシージャの入力と

出力の両方にデータをマップすることができます。トランザクション

が実行されると、ストアドプロシージャの入力にマップされている値

が取得され、ストアドプロシージャに渡されます。ストアドプロシー

ジャが終了すると、マップされている出力が PLCのデータテーブルに

書込まれます。

� RSSqlエンタープライズコネクションにデータを渡す前にデータを処理

するための組込み関数があります。RSSqlの演算式エディタにより、

強力な演算式を作成することができます。

� Oracle Callable Interface (OCI)によるOracleデータベースとのネイティブ

コネクションをサポートしています。この機能は、Oracleエンジンま

たは SQL*NETリモート・クライアント・コネクションに接続するた

めの最も迅速な方法を提供します。NTコンピュータ上に SQL*NETク

ライアントがあると、Oracleがサポートしているあらゆるオペレー

ティングシステム上の Oracleデータベースエンジンとの間で、最適化

された直接リンクを設定することができます。Oracleデータベースと

の接続には、この方法をお奨めします。

� OCI準拠および ODBC準拠のデータベースについて、INSERTおよび

UPDATEモードをサポートしています。

� Microsoft Windows NTのセキュリティ機能を使用して、構成情報やシス

テム管理情報へのアクセスを制限することができます。RSSqlには 3

つのユーザグループがあり、各グループごとに独自のアクセス権限が

あります。
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� RSSqlソフトウェアの構成および使用に関して、コンテキスト依存の幅

広いオンラインヘルプを利用することができます。

ライセンスオプションライセンスオプションライセンスオプションライセンスオプション
RSSqlソフトウェアのライセンスは、以下の 2つの要素に基づいて選択し

ます。

� RSSqlコントロール・コネクション・サービスおよびエンタープライ

ズ・コネクション・サービスを複数のコンピュータで利用するかどう

か

� RSSqlトランザクションマネージャがサポートする最大タグ (データポ

イント )数です。

RSSqlには、プロフェッショナルおよびスタンダードという 2種類のライ

センスクラスがあります。ライセンスクラスは、サポートするオペレー

ティングシステムの数と分散処理のレベルによって分類されます。各ラ

イセンスクラスには、150タグ、300タグ、1500タグ、および無制限とい

う 4種類のスケーラビリティレベルがあります。

以下の表は、RSSqlの各ライセンスクラスがサポートする分散処理のレベ

ルおよび最大タグ数を示します。

Cat. No. ライセンスクラス オペレーティング

システム

分散処理

機能

最大タグ数

9356-PRO2400 Unlimited Professional NTのみ Yes 無制限

9356-PRO2300 Large Professional NTのみ Yes 1500

9356-PRO2200 Medium Professional NTのみ Yes 300

9356-PRO2100 Small Professional NTのみ Yes 150

9356-STD2400 Unlimited Standard NTのみ No 無制限

9356-STD2300 Large Standard NTのみ No 1500

9356-STD2200 Medium Standard NTのみ No 300

9356-STD2100 Small Standard NTのみ No 150
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RSSql のアーキテクチャを理解するRSSql のアーキテクチャを理解するRSSql のアーキテクチャを理解するRSSql のアーキテクチャを理解する
RSSqlシステムの目的は、プラントフロアデバイスのデータを収集して、

必要に応じてデータを操作して、宛先に格納することです。

プラントフロアデータプラントフロアデータプラントフロアデータプラントフロアデータ
RSSqlシステムでは、「プラントフロアデータ」という用語は、データ・

ソース・デバイス、データサーバ、および RSSqlコントロールコネク

ションを意味します。

プラントフロアデータを構成するデータポイントには様々な属性があり

ます。第 1の属性はデータソースです。これは、RSSqlコントロールコネ

クションおよびデータサーバがデータの位置を定義する方法です。デー

タソースには、データサーバと通信を行なう RSSqlコントロールコネク

ション名、データを提供するデータサーバ名、DDEトピック名およびア

イテム文字列が含まれます。RSSqlコントロールコネクション、データ

サーバ、トピックおよびアイテムの組合せに対して、システムで参照す

るための名前が与えられます。
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プラントフロアデータの第 2の属性は、データのやり取りが定期的であ

るか不定期であるかです。この属性は、データが RSSqlトランザクショ

ンマネージャに到達する方法を定義します。

データは、データサーバからの要求に基づいて (ソリシテッド )、または

要求の有無に関わらず (アンソリシテッド )、PLCプロセッサからデータ

サーバに渡されます。データサーバは新しい値を受取ると、その値を

RSSqlコントロールコネクションに転送します。RSSqlコントロールコネ

クションが受取ったデータをどのように処理するかは、データポイント

に対して設定した属性によって異なります。

データポイントが RSSqlの定期データポイントである場合、データポイ

ントは必要になるまでコントロールコネクションにあります。データポ

イントが不定期データポイントである場合、データポイントはすぐに

RSSqlトランザクションマネージャに転送されて処理されます。

DDEコントロールコネクションは、RSSqlトランザクションマネージャ

がデータの受信を確認するまで、不定期データポイントをキューに入れ

ておきます。キューのサイズは 1,000 データポイントであり、ユーザはこ

れを変更できません。キューではデータポイントの加重は行なわれない

ため、1,000個の値をすべて同じ不定期データポイントにすることもでき

ます。1,000個以上の値を受取ると、最も古い値から順番に上書きされま

す。

各データポイントには、コレクションおよび有効性に関するパラメータ

があります。コレクションに関するパラメータでは、コントロールコネ

クションからデータを受取るまでの待機時間、および指定時間内にデー

タが到達しなかった場合の動作を定義します。有効性に関するパラメー

タでは、データが新しいものであるか、それとも再び読取る必要がある

かを判断します。
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トランザクショントランザクショントランザクショントランザクション
RSSqlシステムでは、「トランザクション」という用語は、データを収集、

処理、および格納するためのルールを意味します。

データ収集のルールでは、トランザクションが定期 (タイムベース )イベ

ント、不定期 (制御ベース )イベント、または Visual Basicなどのアプリ

ケーションプログラムの関数呼出しのいずれにより起動するかを定義し

ます。

RSSqlトランザクションでは、データポイントをデータビューのカラムや

ストアドプロシージャと結び付けることができます。データポイントを

特定のデータ位置に結び付けるには、どのデータポイントを RSSql デー

タビューのどのカラムに結びつけるかを選択します。また、データベー

スに渡す前にデータを処理するための演算式を指定することもできます。

データをデータベースに格納するルールでは、トランザクションが終了

した場合、演算結果が True(真 )である場合、指定した数のトランザク

ションが発生した場合、またはデータポイントの値が変更した場合、

データをデータベースに格納するかを定義します。

エンタープライズデータエンタープライズデータエンタープライズデータエンタープライズデータ
RSSqlシステムでは、「エンタープライズデータ」という用語は、RSSql

エンタープライズコネクション、データベースコネクティビティ、およ

びデータベースを意味します。
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データは、トランザクションマネージャから RSSqlエンタープライズコ

ネクションに送られ、さらにデータベースに渡されます。RSSqlエンター

プライズコネクションのデータビューには、データベースコネクション、

データベーステーブルまたはビュー、シノニム、またはストアドプロ

シージャの名前、およびカラムまたはパラメータ (一部分またはすべて )

が表示されます。また、RSSqlデータビューでは、データベースに新しい

行を挿入するか、既存の行を更新するかを指定します。

RSSql のサービスを理解するRSSql のサービスを理解するRSSql のサービスを理解するRSSql のサービスを理解する
RSSqlシステムは、産業用制御システムのデバイスと企業情報システムの

データベースとの接続性を提供するよう設計されています。プロセス制

御分野では、RSSqlは PLCデータテーブルとリレーショナルデータベー

スとの接続性を提供します。

RSSqlシステムは、多様性と拡張性を備えています。RSSqlのアーキテク

チャは、データ・ソース・デバイスとリレーショナルデータベースの論

理接続を構成するために、様々な方法を提供します。以下の図は、RSSql

システムの例を示します。この図では、RSSqlソフトウェアに組込みの

NTシステムサービスがグレーのボックスで表示され、同じコンピュータ

上のすべてのソフトウェアコンポーネントが点線で囲まれています。
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この例は、RSSqlトランザクションマネージャがインストールされたコン

ピュータがネットワーク上の他のコンピュータに接続されています。図

の下側にある 2台のコンピュータは、データ収集に使用されます。これ

らのコンピュータには、RSSqlコントロール・コネクション・サービスお

よび RSLinx Advanced DDEサーバがインストールされています。また、

各コンピュータは 3つの PLCプロセッサから構成される産業用ネット

ワークに接続されています。

図の上側にある 4台のコンピュータは、データ格納に使用されます。こ

れらのコンピュータには、RSSqlエンタープライズ・コネクション・サー

ビス、データベースサーバ、およびデータベースがインストールされて

います。

RSSqlソフトウェアには、トランザクションマネージャ、コントロールコ

ネクション、およびエンタープライズコネクションという 3種類の NT

サービスがあります。これらのサービスは、RSSqlトランザクションビル

ダにより構成します。
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RSSqlトランザクションビルダトランザクションビルダトランザクションビルダトランザクションビルダ
RSSqlトランザクションビルダは、トランザクションを作成および構成す

るためのグラフィカル・ユーザ・インターフェイスです。

RSSqlトランザクションビルダには、参照の統合性があります。これは、

構成情報の 1つのエレメントを削除すると、そのエレメントを参照して

いるすべてのエレメントも削除されることを意味します。したがって、

ある RSSql データポイントを削除すると、そのデータポイントを参照し

ているトランザクションは、明示的に参照していても、演算式により参

照していても、すべて削除されます。

RSSqlトランザクション・マネージャ・サービストランザクション・マネージャ・サービストランザクション・マネージャ・サービストランザクション・マネージャ・サービス
RSSqlトランザクションマネージャは、データの収集、処理、および格納

を設定するための NTサービスです。このサービスには、イベントトリガ

のスケジューリング、演算式の評価、定期データポイントの要求、およ

びデータを格納できることを RSSqlエンタープライズコネクションに通

知することが含まれます。

RSSqlトランザクションマネージャでは、トランザクションのオカレンス

ごとに、データをバッファします。これは、あるデータポイントを参照

する各トランザクションがその値のローカルストレージを保持している

ことを意味します。ローカルストレージという方法を使用すると、ある

トランザクションの値が別のトランザクションの値に誤って上書きされ

ることを防ぐことができます。

例えば、2つのトランザクションがあるとします。各トランザクション

は、あるデータポイントの最後の 5つの値の平均値です。トランザク

ション Aは 10秒ごとに起動して、トランザクション Bは 15秒ごとに起

動します (データポイントの値は、トランザクション Aまたはトランザ

クション Bによって 5秒ごとに読取られます )。データはバッファされて

いるため、トランザクション Bが読取った値は トランザクション Aが読

取った値を上書きしません。
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次に、トランザクションが不定期に起動し、各トランザクション用に

データのオカレンスが格納されているとします。この場合、トランザク

ション Aは n～ n+5の平均値を算出し、トランザクション Bは n+1～

n+6の平均値を算出します。

RSSqlコントロール・コネクション・サービスコントロール・コネクション・サービスコントロール・コネクション・サービスコントロール・コネクション・サービス
コントロール・コネクション・サービスは、フィールドデバイスのデー

タを収集します。コントロール・コネクション・サービスには、DDEお

よび RSView32の 2種類があります。

DDEコントロールコネクションによりデータを収集する場合、DDE コン

トロール・コネクション・サービスおよび DDEサーバの両方が 1台のコ

ンピュータで動作している必要があります。

RSView32コントロールコネクションによりデータを収集する場合、

RSView32コントロール・コネクション・サービスおよび RSView32の両

方が 1台のコンピュータで動作している必要があります。また、

RSView32のプロジェクトが動作しており、DDEサーバオプションが有

効になっている必要があります。

RSSqlエンタープライズ・コネクション・サービスエンタープライズ・コネクション・サービスエンタープライズ・コネクション・サービスエンタープライズ・コネクション・サービス
エンタープライズ・コネクション・サービスは、データをデータベース

に格納します。エンタープライズ・コネクション・サービスには、OCI

および ODBCの 2種類があります。いずれのサービスも同様の機能があ

ります。

RSSqlトランザクション・マネージャ・サービスは、データベースへの格

納を実行する前に、エンタープライズコネクションに格納されているす

べてのトランザクションをエンタープライズコネクションのログファイ

ルに書き込みます。このログファイルは、データベースに格納されるま

では、ホストコンピュータにあります。データの格納が実行されると、

RSSqlエンタープライズコネクションは RSSqlトランザクションマネー

ジャに対して、ログファイルが処理されたことを知らせます。これによ

り、トランザクションマネージャはログファイルを削除します。
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データベースが使用できないなどの理由により、データの格納が実行さ

れなかった場合、ログファイルは削除されず、RSSqlエンタープライズコ

ネクションが次にサービスを起動したときに、そのデータが再び使用さ

れます。

データベースとの接続は有効なのに、トランザクションを格納できない

場合、RSSqlエンタープライズコネクションは *.SQLファイルを作成し

ます。エラーが解決すると、このファイルにはユーザがロードするデー

タが入ります。

データ格納の通知がすぐに必要な場合、ログファイルを作成せずにデー

タをリアルタイムに格納することもできます。

RSSql を操作するRSSql を操作するRSSql を操作するRSSql を操作する
RSSqlソフトウェアを初めて起動すると、RSSqlシステムのグラフィック

がワークスペースに表示されます。このグラフィックのいずれかのボタ

ンをクリックすると、対応する RSSqlサービスのオンラインヘルプが表

示されます。

Quick Startボタンをクリックすると、別のウィンドウに一連の命令が表

示され、RSSqlソフトウェアを構成および使用する方法を示します。

RSSqlのメインウィンドウには、タイトルバー、メニューバー、ツール

バー、ワークスペース、およびステータスバーというエレメントがあり

ます。次に、これらのエレメントについて説明します。

タイトルバータイトルバータイトルバータイトルバー
タイトルバーには、RSSqlアイコン、RSSqlの現在の構成の名前、ソフト

ウェア製品の名前 (RSSql), Minimizeボタン、Maximizeボタン、および

Closeボタンが表示されます。

RSSqlシステムのグラフィックを非表示にするには、RSSqlメ

ニューで View > Transaction Configurationを選択します。

TIP
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Control Menuを参照するには、タイトルバーで RSSqlアイコンをクリッ

クします。Control Menuには、以下の項目が表示されます。

メニューバーメニューバーメニューバーメニューバー
RSSqlのメニューバーには、以下のメニューが表示されます。

ツールバーツールバーツールバーツールバー
RSSqlのツールバーには、以下の 5つのボタンが表示されます。各ボタン

は、RSSqlメニューからも使用することができます。

項目 内容

Restore Maximizeコマンドによりウィンドウを最大化したり、Minimizeコ

マンドによりウィンドウを最小化した後に、ウィンドウを元のサ

イズに戻す場合、Restoreを選択します。

Move キーボード上の矢印キーによりデスクトップ上のウィンドウの位

置を変更する場合、Moveを選択します。

Size キーボード上の矢印キーによりウィンドウのサイズを変更する場

合、Sizeを選択します。

Minimize ウィンドウを最小化して、タスクバーのアイコンとして表示する

場合、Minimizeを選択します。これは、タイトルバーでMinimize

ボタンをクリックするのと同じです。

Maximize ウィンドウを最大化して、画面全体に表示する場合、Maximizeを

選択します。これは、タイトルバーでMaximizeボタンをクリック

するのと同じです。

Close RSSqlアプリケーションを終了する場合、Closeを選択します。こ

れは、タイトルバーで Closeボタンをクリックするのと同じです。
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ワークスペースワークスペースワークスペースワークスペース
ウィンドウのワークスペースは、2つの部分に分かれています。左側の

ウィンドウは、現在の RSSqlの構成のツリービューです。ここには、こ

の構成用に定義されたコントロール・コネクション・サービスおよびエ

ンタープライズ・コネクション・サービスが表示されます。信号機アイ

コンの色は、RSSqlの構成およびサービスのステータスを示します。緑色

は、サービスが実行中であることを示します。黄色は、コントロール・

コネクション・サービスまたはエンタープライズコネクションの 1つが

実行中ではないことを示します。赤色は、サービスが実行中ではないこ

とを示します。

アイコン 内容

新しい RSSqlの構成情報を作成する場合、このボタンをクリック

します。これは、RSSqlメニューで Configuration > Newを選択す

るのと同じです。

About RSSqlダイアログを参照する場合、このボタンをクリックし

ます。これは、RSSqlメニューで Help > About RSSqlを選択する

のと同じです。

コンテキスト依存のヘルプを参照する場合、このボタンをクリッ

クして、ヘルプを参照したいエレメントの上にカーソルを置いて、

右クリックします。

構成ツリーで選択している RSSqlの構成または NTサービスを開

始する場合、このボタンをクリックします。これは、RSSqlメ

ニューで Configuration > Startを選択する、またはマウスの右ボ

タンメニューで Start Service Instanceを選択するのと同じです。

構成ツリーで選択している RSSqlの構成または NTサービスを終

了する場合、このボタンをクリックします。これは、RSSqlメ

ニューで Configuration > Stopを選択する、またはマウスの右ボタ

ンメニューで Stop Service Instanceを選択するのと同じです。
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右側のウィンドウには、ビューオプションの選択によって、トランザク

ション構成ビュー、トランザクション・モニタ・ビュー、構成ログ・

ファイル・ビュー、または RSSqlシステムグラフィックが表示されます。

ステータスバーステータスバーステータスバーステータスバー
RSSqlウィンドウの下側のステータスバーには、RSSqlソフトウェアのス

テータスおよびキーボードに関する情報が表示されます。

ステータスバーの左部分には、RSSqlソフトウェアの動作に関する情報が

表示されます。例えば、RSSqlメニューであるメニュー項目を強調表示す

ると、そのメニュー項目の概要がステータスバーに表示されます。

ステータスバーの右部分には、Caps Lock (CAP)キー、Number Lock 

(NUM)キー、および Scroll Lock (SCRL)キーが有効かどうかが表示されま

す。
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クイックスタートの手順クイックスタートの手順クイックスタートの手順クイックスタートの手順
この項では、RSSqlソフトウェアをインストールした後に、このソフト

ウェアを構成および使用する方法について説明します。RSSqlソフトウェ

アのインストール方法は、製造管理情報システムのアーキテクチャに

よって異なります。すべての RSSql NTサービスを 1台のコンピュータに

インストールする (ローカル環境 )ことも、コントロール・コネクショ

ン・サービスおよびエンタープライズ・コネクション・サービスをリ

モートコンピュータにインストールすることもできます (ネットワーク環

境。RSSql Professionalエディションが必要です )。RSSqlソフトウェアを

インストールする方法は、第 2章を参照してください。

ここでは、各機能の特徴と作業の流れを大まかに示すため、詳しい説明

は省略します。各ステップの詳しい説明は、各ステップの指示に従って

本書の該当部分を参照するか、オンラインヘルプを使用してください。

ステップステップステップステップ 1 � RSSqlの構成を作成するの構成を作成するの構成を作成するの構成を作成する
RSSqlソフトウェアをインストールしたら、以下を行ないます。

� RSSqlの構成を作成します。RSSqlの構成を作成すると、RSSqlの構成ツ

リーに表示されます。

� 構成パラメータ (構成ファイルの構成名およびパス )を定義して、構成で

使用する RSSqlコネクションサービスを選択します。

� この NTサービスについて、RSSqlトランザクションマネージャ (ホスト

名、ポート、ユーザ名、およびパスワードを指定する )を構成します。

RSSqlソフトウェアをパーソナルコンピュータにインストー

ルして使用する前に、RSSqlのアーキテクチャ、サービス、

および用語について学習することを強くお奨めします。オン

ラインチュートリアルを実行することにより、これを行なう

ことができます。

基本的な操作方法を理解していると、RSSqlソフトウェアを

より簡単にインストール、構成、および使用することができ

ます。「RSSqlのアーキテクチャを理解する」という項をまだ

読んでいない方は、是非お読みください。RSSqlソフトウェ

アの基本概念を理解するために費やした時間は有意義だった

と納得されることと思います。

TIP
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� 構成で使用するロギングパラメータを指定します。

RSSqlの構成を作成および構成する方法は、第 3章を参照してください。

ステップステップステップステップ 2 � RSSqlコントロールコネクションを作コントロールコネクションを作コントロールコネクションを作コントロールコネクションを作
成および構成する成および構成する成および構成する成および構成する

各構成には、1つまたはそれ以上の RSSqlコントロールコネクションが

入っています。RSSqlの構成を作成したら、以下を行ないます。

� 構成で使用するコントロール・コネクション・サービスのインスタン

スを作成します。コントロールコネクションを作成すると、ツリー

ビューに表示されます。

� RSSqlのデータポイントを追加することにより、作成したコントロール

コネクションを構成します。データポイントは、タグ名または DDEア

イテムの文字列により追加することができます。データポイントは、1

つずつまたはグループ単位で追加することができます。

RSSqlコントロールコネクションを作成および構成する方法は、第 4章を

参照してください。

ステップステップステップステップ 3 � RSSqlエンタープライズコネクションを作エンタープライズコネクションを作エンタープライズコネクションを作エンタープライズコネクションを作
成および構成する成および構成する成および構成する成および構成する

各構成には、1つまたはそれ以上の RSSqlエンタープライズコネクション

が入っています。RSSqlコントロールコネクションを作成したら、以下を

行ないます。

� 構成で使用するエンタープライズ・コネクション・サービスのインス

タンスを作成します。エンタープライズコネクションを作成すると、

ツリービューに表示されます。

� データビューを追加することにより、作成したエンタープライズコネ

クションを構成します。テーブル、ビュー、シノニム、またはストア

ドプロシージャが入っているデータビューを追加することができます。

動的データ交換 (DDE)プロトコルを使用してデータを収集す

る前に、DDEサーバを設定する必要があります。RSLinx 

AdvancedDDEサーバの設定については、付録 Dを参照してく

ださい。

TIP

TIPTIP
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RSSqlエンタープライズコネクションを作成および構成する方法は、第 5

章を参照してください。

ステップステップステップステップ 4 � RSSqlのトランザクションを構成するのトランザクションを構成するのトランザクションを構成するのトランザクションを構成する
コントロールコネクションおよびエンタープライズコネクションは、任

意の順序で構成することができますが、コントロールコネクションおよ

びエンタープライズコネクションをそれぞれ 1つ以上構成するまでは、

トランザクションを構成することができません。コントロールコネク

ションおよびエンタープライズコネクションを構成したら、以下を行な

います。

� RSSqlのデータポイントをデータビューのカラムに結び付けて、データ

収集のトリガおよびデータベースへの格納を指定することにより、ト

ランザクションを構成します。データベースに格納する前に収集した

データを処理したい場合、RSSqlの演算式エディタにより演算式を作

成することができます。トランザクションを作成すると、RSSqlトラ

ンザクション構成ビューに表示されます。

RSSqlのトランザクションを構成する方法は、第 6章を参照してくださ

い。

ステップステップステップステップ 5 � RSSqlの構成を開始するの構成を開始するの構成を開始するの構成を開始する 
RSSqlコントロールコネクションおよび RSSqlエンタープライズコネク

ションがそれぞれ 1つ以上構成され、RSSqlトランザクションが 1つ以上

構成されている RSSqlの構成を作成したら、RSSqlソフトウェアを使用

して、PLCプロセッサのデータをデータベースに移動することができま

す。 RSSqlの構成を開始するには、以下を行ないます。

� RSSqlの構成を選択します。

RSSqlエンタープライズコネクションでデータビューを定義

する前に、データベースとの接続を設定する必要があります。

ODBC準拠のデータベースの場合、システムのデータソース

名 (DSN)により接続を行ないます。ODBCデータソースの設

定については、付録 Cを参照してください。

TIP
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� RSSqlの構成を開始します。新しいレコードがデータベースに追加され

るか、既存のデータベースレコードが更新されるかは、データビュー

の構成内容によって異なります。

RSSqlソフトウェアを使用する方法は、第 7章を参照してください。

         

ツリービューの信号機アイコンの色は、プロジェクトの各

RSSqlのサービスのステータスを示します。緑色は、サービ

スが実行中であることを示します。黄色は、コントロール・

コネクション・サービスまたはエンタープライズコネクショ

ンの 1つが実行中ではないことを示します。赤色は、サービ

スが実行中ではないことを示します。

TIP
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Chapter

RSSqlをインストールおよび開始するをインストールおよび開始するをインストールおよび開始するをインストールおよび開始する

この章では、RSSqlソフトウェアをインストールおよび開始する方法につ

いて説明します。

RSSqlソフトウェアをインストールした後に、リリースノートを読むこと

をお奨めします。リリースノートには、本書の発行後の最新情報が記載

されています。リリースノートを参照するには、RSSqlソフトウェアを開

始して、RSSqlメニューで Help > Release Notesを選択します。

インストールを行なう前にインストールを行なう前にインストールを行なう前にインストールを行なう前に
RSSqlソフトウェアをインストールする前に、以下を理解しておく必要が

あります。

� ハードウェア要件

� ソフトウェア要件

� Windows NTユーザグループ

� コピープロテクト機能

� RSSqlを 1台のコンピュータにインストールする

� RSSqlを複数のコンピュータにインストールする

ハードウェア要件ハードウェア要件ハードウェア要件ハードウェア要件
RSSqlソフトウェアを有効に使用するには、コンピュータが以下を装備し

ている必要があります。

� Pentium™または Pentium互換のマイクロプロセッサ

� 32MBの RAM

� CD-ROMドライブ

� 3.5インチのフロッピー・ディスク・ドライブ

この章に記載された機能を実行するには、Windows NTのシス

テム管理者権限が必要です。適切な権限をお持ちでない場合、

システム管理者に相談してください。

TIP
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� 20MBのハード・ディスク・スペース

ソフトウェア要件ソフトウェア要件ソフトウェア要件ソフトウェア要件
RSSqlソフトウェアを有効に使用するには、コンピュータに以下のソフト

ウェアがインストールされている必要があります。

� Microsoft Windows NT Ver. 4.0以降

(RSSqlソフトウェア では、Windows NTの以前のバージョン、

Windows 95, およびWindows 3.xオペレーティングシステムはサポート

していません。) 

� DDEコントロールコネクションを使用する場合、RSSql DDEコント

ロール・コネクション・サービスがインストールされているコン

ピュータ上に、RSLinx Ver. 1.7以降、通信ソフトウェア、または他の

AdvancedDDEまたは CF_Textサーバがインストールされている必要が

あります。RSLinxを使用する場合、NTサービスとして動作している

必要があります。

� RSView32コントロールコネクションを使用する場合、RSView32コン

トロール・コネクション・サービスがインストールされているコン

ピュータ上に、RSView32 Ver. 6.0以降がインストールされている必要

があります。

� エンタープライズコンピュータの場合、ODBC Managerおよび ODBCド

ライバ (Ver. 2.x以降 )または CIおよび SQL*NET (Ver. 2.3.x以降 )。

Windows NTユーザグループユーザグループユーザグループユーザグループ
RSSqlソフトウェアでは、Windows NTオペレーティングシステムのセ

キュリティ機能を使用するため、各 RSSqlユーザ権限 (Admin, Modify, お

よび View)は、対応するWindows NTユーザグループ (RSSql_Admin, 

RSSql_Modify, および RSSql_View)を持っている必要があります。



RSSqlをインストールおよび開始する   �  23

RSSqlユーザ権限は、どのWindows NTユーザグループに属しているかに

よって異なります。以下の表は、RSSqlユーザ権限とWindows NTユーザ

グループの関係を示します。

RSSqlソフトウェアを使用する前に、Windows NTのシステム管理者はこ

れらのWindows NTユーザグループを作成して、RSSqlユーザをこれらの

Windows NTユーザグループに追加する必要があります。NTユーザグ

ループの作成については、付録 Bを参照してください。

ユーザが NTドメインにログインすると、RSSqlソフトウェアはドメイン

コントローラでユーザ権限を検査します。ユーザが適切な権限を持って

いない場合、RSSqlソフトウェアはローカルシステム上のユーザ権限を使

用します。

コピープロテクト機能コピープロテクト機能コピープロテクト機能コピープロテクト機能
ロックウェル・ソフトウェアでは、ソフトウェアキーによりWindows

ベースのソフトウェア製品のコピープロテクトを行なっています。コ

ピープロテクトされたソフトウェア製品には、固有のキーがあります。

このキーは、ソフトウェアに付属のマスタディスク上のアクティベー

ションファイルに格納されています。

RSSqlソフトウェアは、様々なコンポーネントから構成されますが、コ

ピープロテクトされるのは RSSqlトランザクションマネージャだけです。

このサービスは、1ライセンスにつき同時に 1台のコンピュータにのみイ

ンストールすることができます。

ユーザ権限 RSSql_Admin RSSql_Modify RSSql_View

RSSqlの構成を参照する Yes Yes Yes

RSSqlの構成を変更する Yes Yes No

RSSqlの構成を開始 /終

了する

Yes No No
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RSSqlトランザクション・マネージャ・サービスをインストールすると、

セットアッププログラムは RSSqlマスタディスクをフロッピー・ディス

ク・ドライブに挿入するようプロンプトを表示します。次に、Move 

Activationユーティリティは、アクティベーションキーを RSSqlマスタ

ディスクからハードディスクに移動します。後に、アクティベーション

キーを別のコンピュータに移動したり、削除する場合、RSSqlマスタディ

スクにキーを戻す必要があります。ソフトウェアキー、コピープロテク

ト機能、およびソフトウェアアクティベーションについては、付録 Aを

参照してください。

RSSqlコントロール・コネクション・サービスおよびエンタープライズ・

コネクション・サービスは、コピープロテクトされません。RSSql 

Professionalをご使用のユーザは、これらのサービスのコピーを複数のコ

ンピュータにインストールすることができます。

RSSqlをををを 1台のコンピュータにインストールする台のコンピュータにインストールする台のコンピュータにインストールする台のコンピュータにインストールする
RSSqlのすべてのサービスを 1台のコンピュータにインストールする場

合、セットアッププログラムを実行して、RSSqlのすべてのコンポーネン

トを現在使用しているコンピュータ上にインストールするよう選択しま

す。

RSSqlを複数のコンピュータにインストールするを複数のコンピュータにインストールするを複数のコンピュータにインストールするを複数のコンピュータにインストールする
RSSqlを複数のコンピュータにインストールする、すなわち RSSqlコン

トロール・コネクション・サービスおよびエンタープライズ・コネク

ション・サービスをリモート・コンピュータ・システム (RSSqlトランザ

クション・マネージャ・サービスがインストールされていないコン

ピュータ )にインストールする場合、インストール先となる各コンピュー

タ上でセットアッププログラムを実行して、そのコンピュータにインス

トールする RSSqlサービスを選択します。

RSSqlソフトウェアを複数のコンピュータにインストールする場合、以下

の点を確認してください。

� すべてのコンピュータがWindows NTオペレーティングシステムを使用

しているかどうか。



RSSqlをインストールおよび開始する   �  25

� すべてのコンピュータが TCP/IPを使用するネットワークに接続されて

いるか。

� RSSqlシステムを構成するすべてのコンピュータにおいて、RSSqlトラ

ンザクションマネージャがシステム管理者権限を持つWindows NTア

カウントに結び付けられているか。

� ユーザが作成したRSSqlの構成が汎用命名規則 (UNC)に準拠するパスを

持っているか。これは、リモートコンピュータ上の RSSqlサービスが 

RSSqlトランザクションビルダ GUIの管理下にある構成ファイルを検

索するための方法です。UNCファイルにアクセスするには、RSSqlコ

ントロールコネクションまたはエンタープライズコネクションのイン

スタンスを定義するたびに、そのインスタンスが動作するリモートコ

ンピュータのホスト名を指定して、そのインスタンスを適切な権限を

持つユーザアカウントに割当てる必要があります。

� RSSqlエンタープライズコネクションがリモートコンピュータ上にある

場合、ローカルコンピュータとリモートコンピュータの両方でター

ゲットデータベースの OCIまたは ODBC接続を提供する必要がありま

す。両方の接続は、同じ名前でなければなりません。この接続は、

RSSqlトランザクションビルダ GUIがデータベースからカタログ情報

を入手したり、RSSqlエンタープライズコネクションがデータをデー

タベースに送るために必要です。

� RSSqlコントロールコネクションがリモートコンピュータ上にある場

合、RSSql DDE Data Point Configurationダイアログで DDEトピック名

を入力するか、または両方のコンピュータに RSLinxをインストールす

る必要があります。RSSqlトランザクションビルダ GUI は、リモート

DDEサーバの構成済みの DDEトピックを検索してリストボックスに

表示することはできません。
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RSSql ソフトウェアをインストールするRSSql ソフトウェアをインストールするRSSql ソフトウェアをインストールするRSSql ソフトウェアをインストールする
RSSqlソフトウェアをインストールする場合、ディレクトリおよびプログ

ラムグループを指定することができます。ディレクトリおよびプログラ

ムグループのデフォルト名は、それぞれ Program Files\Rockwell Software

および Rockwell Softwareです。特に理由がない場合、デフォルト名を使

用することをお奨めします。

本書およびオンラインヘルプでは、ユーザがデフォルト名を使用してい

ると仮定して説明を行ないます。デフォルト名を使用していないユーザ

は、実際に使用している名前に置換えて、本書およびオンラインヘルプ

をお読みください。

RSSqlソフトウェアをインストールするには、以下を実行します。

1. PCを起動します。

2. Windows NTが自動的に起動されない場合、Windows NTを起動しま

す。

3. RSSqlの CD-ROMを CD-ROMドライブに挿入します。Windows NT

のオートプレイ機能が無効でないかぎり、数秒後に RSSqlのスプ

ラッシュスクリーンが表示されます。RSSqlのインストールを開始す

るには、Install RSSqlをクリックします。オートプレイ機能が無効で

ある場合、Startをクリックして、Runをクリックします。Runダイ

アログボックスの Openフィールドで、drive:\install\setup(driveは

RSSqlの CD-ROMが入っているドライブ名 )を入力して、OKをク

リックします。

4. 画面上の指示に従います。

Registration Information画面

ユーザ名、会社名、および RSSqlソフトウェアのシリアル番号を入

力します。シリアル番号は、RSSqlマスタディスクのラベルに記載さ

れています。

 RSSqlソフトウェアをインストールする前に、Windowsのア

プリケーションプログラムをすべて終了することをお奨めし

ます。

TIP
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Select Folder画面

RSSqlファイルのインストール先として、デフォルトのディレクトリ

を受入れるか、または新しいディレクトリ名を選択します 。特に理

由がない場合、デフォルトのディレクトリに RSSqlファイルをイン

ストールすることをおすすめします。

Select Components画面

画面の左側で RSSqlを選択して、画面の右側でこのコンピュータに

インストールする RSSqlソフトウェアのコンポーネントを選択しま

す。

Specify Start Menu Item画面

アプリケーションアイコンのインストール先として、デフォルトのプ

ログラムフォルダを受入れるか、またはプログラムフォルダ名を入力

します。特に理由がない場合、デフォルトのプログラムフォルダにア

イコンをインストールすることをお奨めします。

確認画面

選択内容を確認します。Nextをクリックすると、ハード・ディスク・

ドライブへのファイルのコピーが開始され、インストールプロセスの

ステータスがポップアップウィンドウに表示されます。

Setup Says!画面

テクニカルサポートの電話番号を確認して、Nextをクリックします。

テクニカルサポートの電話番号を再び参照するには、メニューで

Help > About RSSqlを選択します。
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RSSql Setup is Complete画面

RSSqlコントロールコネクションおよびエンタープライズコネクショ

ンをリモートコンピュータにインストールする場合、Activate RSSql

のチェックマークをオフにします。セットアッププログラムの終了後

すぐに RSSqlオンライン・ヘルプ・システムを表示しない場合、

View the ReadMe file nowのチェックマークをオフにします。RSSqlト

ランザクション・マネージャ・サービスをインストールする場合、

RSSqlマスタディスクを 3.5インチ・フロッピー・ディスク・ドライ

ブに挿入します。これらの選択を行ない、Finishをクリックします。

両方のチェックボックスをオフにしていない場合、RSSqlを使用可能

にするようプロンプトが表示され、オンライン・ヘルプ・システムが

表示されます。

5. RSSqlソフトウェアのインストールが終了したら、RSSqlの CD-ROM

とマスタディスクを各ドライブから取り出して、安全な場所に保管し

ます。

RSSql ソフトウェアを開始するRSSql ソフトウェアを開始するRSSql ソフトウェアを開始するRSSql ソフトウェアを開始する
以下の説明では、ユーザがデフォルトのディレクトリ名およびプログラ

ムグループ名を使用していると仮定しています。そうでない場合、デ

フォルト名を実際に使用している名前に置換えてください。

RSSqlソフトウェアを開始するには、Startボタンをクリックして、Start

メニューで Programs > Rockwell Software > RSSql > RSSqlをクリックし

ます。

RSSqlソフトウェアを開始する前に、Windows NTのシステム

管理者によって、RSSqlユーザに必要な Windows NTユーザグ

ループを作成して、これらのグループに RSSqlユーザを追加

しておく必要があります。これを行なわないと、RSSqlオン

ライン・ヘルプ・システムにしかアクセスすることができま

せん。

TIP
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RSSqlの構成を作成するの構成を作成するの構成を作成するの構成を作成する

この章では、RSSqlの構成を作成する方法、および構成のロギングパラ

メータを設定する方法について説明します。

編集ボックスやリストボックスなどの画面エレメントに関する詳しい情

報を参照するには、コンテキスト依存ヘルプを使用してください。ヘル

プを参照するための 1つの方法は、ヘルプを参照したい画面エレメント

の上にカーソルを置いて、F1キーを押します。

構成を作成する構成を作成する構成を作成する構成を作成する
RSSqlの構成を作成するには、以下を実行します。

1. RSSqlメニューで Configuration > Newを選択します。これにより、

RSSql Configurationダイアログが表示されます。

2. RSSql構成ファイル (*.DAT)で使用する構成およびパスの名前を指定

します。

3. RSSql の構成で使用するエンタープライズコネクションおよびコント

ロールコネクションのタイプを選択します。

4. Applyをクリックします。これにより、Service Instanceダイアログが

表示されます。

5. Service Nameフィールドで Transaction Managerが選択されていない

場合、Transaction Managerを選択します。

6. RSSql の構成で使用するホスト名、TCP/IP受信ポート、ユーザ名、お

よびパスワードを指定します。デフォルトのホスト名およびユーザ名

は、それぞれ現在のコンピュータおよび現在のユーザです。

7. 設定が終了したら、Applyをクリックします。これにより、選択内容

が保存され、Service Instanceダイアログがクローズします。

8. RSSql Configurationダイアログで、Closeをクリックします。これに

より、作成した構成がツリーに追加されます。
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9. ツリーでプラス記号 (+)をクリックすると、構成がオープンして、こ

の構成に関連のあるコントロールコネクションおよびエンタープライ

ズコネクションが表示されます。

ロギングパラメータを設定するロギングパラメータを設定するロギングパラメータを設定するロギングパラメータを設定する
構成のパラメータを設定するには、以下を実行します。

1. RSSqlメニューで Define > Configuration Loggingを選択します。これ

により、Loggingダイアログが表示されます。

2. NT Event Viewer Messages groupで、NT Event Viewerに送信するメッ

セージのタイプをチェックします。

3. File Messages groupで、RSSqlログファイル (*.LOG)に送信するメッ

セージのタイプをチェックします。次に、ログファイルのタイプを指

定します。最後に、メッセージの最大数およびログファイルの最大サ

イズを指定します。

4. SMTP E-Mail Messages groupで、電子メールアカウントに送信する

メッセージのタイプをチェックします。大量の電子メールトラフィッ

クが発生する可能性があるため、必要以上のタイプを選択してはなり

ません。次に、送信元アカウントおよび送信先アカウントの情報を指

定します。

5. 設定が終了したら、OKをクリックします。これにより、選択内容が

保存され、このダイアログがクローズします。

RSSql の構成に関する注意事項 RSSql の構成に関する注意事項 RSSql の構成に関する注意事項 RSSql の構成に関する注意事項 
RSSqlの構成に関する注意事項を以下に示します。

データファイルデータファイルデータファイルデータファイル
RSSqlの各構成には、データファイルのグループが関連付けられていま

す。これらのファイルは、DATという拡張子を持ち、 構成で指定した

ディレクトリに格納されています。これらのファイルが格納されている

ディレクトリは、指定されたドメイン名、ユーザ名、およびパスワード

として実行するすべての NTサービスによって読取りおよび書込みアクセ

ス可能でなければなりません。
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ログファイルログファイルログファイルログファイル
Loggingダイアログの File Messages groupでいずれかのオプションを

チェックしている場合、RSSqlの実行時に、各 RSSql NTサービスのログ

ファイルが作成されます 。これらのファイルには、RSSql NTサービスが

生成したエラーメッセージが格納されます。ログファイル名は、以下の

とおりです。

� トランザクションマネージャのログファイルは、TRANMGR.LOGで

す。

� コントロール・コネクション・サービスのログファイルは、*.LOGで

す。ただし、ファイル名は、コントロール・コネクション・サービス

のインスタンス名です。

� エンタープライズ・コネクション・サービスのログファイルは、

*.LOGです。ただし、ファイル名は、エンタープライズ・コネクショ

ン・サービスのインスタンス名です。

これらは、構成の実行時に RSSqlに関する情報を格納するプレーン・テ

キスト・ファイルです。RSSqlサービスが正しく動作しない場合、ログ

ファイルの内容を参照して、エラーの原因を判断することができます。

これらのファイルを参照するには、RSSqlログビューワを使用します。

ビューワにアクセスするには、RSSqlメニューで View > Configuration 

Log Filesを選択します。
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RSSqlコントロールコネクションをコントロールコネクションをコントロールコネクションをコントロールコネクションを
構成する構成する構成する構成する

RSSqlトランザクションマネージャと PLCプロセッサなどのフィールド

デバイスとの間のデータ交換は、1つまたは複数の RSSqlコントロールコ

ネクションにより行なわれます。各 RSSql構成は、1つ以上の有効なコン

トロールコネクションを持っていなければなりません。

現在、動的データ交換 (DDE)および RSView32という 2種類のコント

ロールコネクションがあります。どちらもWindows NTサービスであり、

双方向のデータ転送をサポートしています。この章では、これらのコン

トロールコネクションのインスタンスを作成および構成する方法につい

て説明します。

DDE コントロールコネクションDDE コントロールコネクションDDE コントロールコネクションDDE コントロールコネクション
DDEコントロールコネクションは、DDEサーバを介して PLCプロセッ

サからデータを収集して、そのデータを RSSqlトランザクションマネー

ジャで使用できるようにするための NTサービスです。このコントロール

コネクションでは、AdvancedDDEまたは CF_TEXTフォーマットを使用

する DDEサーバをすべてサポートしています。ここには、RSLinxサー

バ、RSViewサーバ、および DDE Server Toolkitにより作成された他の

RSServersが含まれます。

次に、DDEコントロール・コネクション・サービスのインスタンスを作

成および構成する方法について説明します。DDEコントロールコネク

ションを作成および構成するには、RSSql変更権限を 1つ以上持っている

必要があります。適切な権限をお持ちでない場合、システム管理者に相

談してください。

編集ボックスやリストボックスなどの画面エレメントに関す

る詳しい情報を参照するには、コンテキスト依存ヘルプを使

用してください。ヘルプを参照するための 1つの方法は、ヘ

ルプを参照したい画面エレメントの上にカーソルを置いて、

F1キーを押します。

TIP
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DDEコントロール・コネクション・サービスのインスタンコントロール・コネクション・サービスのインスタンコントロール・コネクション・サービスのインスタンコントロール・コネクション・サービスのインスタン
スを作成するスを作成するスを作成するスを作成する
 DDEコントロールコネクションのインスタンスを作成するには、以下を

実行します。

1. ツリービューで DDE Connectionを選択して、RSSqlメニューで

Define Service Instanceを選択します。これにより、Service Instanceダ

イアログが表示されます。

2. Service Nameフィールドで DDE Connectionが選択されていない場

合、DDE Connectionを選択します。

3.  DDEコントロールコネクションのインスタンス名 (このコネクショ

ンの名前 )、ホスト名、ユーザ名、およびパスワード名を指定しま

す。デフォルトのホスト名およびユーザ名は、それぞれ現在のコン

ピュータおよび現在のユーザです。

4. 設定が終了したら、Applyをクリックして、選択内容を保存します。

5. さらに別の DDEコントロールコネクションを追加するには、ステッ

プ 3～ 4を繰返します。

6. 作業が終了したら、Closeをクリックします。これにより、作成した

DDEコントロールコネクションがツリービューに追加されます。

DDEコントロールコネクションを構成するコントロールコネクションを構成するコントロールコネクションを構成するコントロールコネクションを構成する
DDEコントロールコネクションのインスタンスを構成するには、以下を

実行します。

1. ツリービューで構成する DDEコレクションを選択して、RSSqlメ

ニューで Define > Service Instance Dataを選択します。これにより、

DDE Data Point Configurationダイアログが表示されます。

2. このコネクションに追加するデータポイントのインスタンス名、

DDEサーバ名、および DDEトピック名を選択します。

3. Addをクリックすると、Data Point Configurationダイアログが表示さ

れます。
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4. Item Stringまたは Tag Fileを選択します。Item Stringを選択した場

合、DDE アイテムの文字列 (例：N7:0)を入力します。Tag Fileを選

択した場合、タグを選択します。

5. Collection Parametersをクリックすると、Collection Parametersダイア

ログが表示されます。

6. コレクションのタイプ、タイムアウトプロパティ、および代替えオプ

ションを選択します。

7. OKをクリックすると、Data Point Configurationダイアログに戻りま

す。

8. 必要であれば、データポイント名およびデータタイプを編集します。

Applyをクリックする際に Data Point Nameフィールドが空白である

場合、現在のデータポイントが適用され、自動的に名前が付けられま

す。

9. Applyをクリックします。

10. さらに別のデータポイントを構成するには、ステップ 3～ 9を繰返し

ます。

11. 作業が終了したら、Closeをクリックします。

DDEコントロールコネクションの構成に関するヒントコントロールコネクションの構成に関するヒントコントロールコネクションの構成に関するヒントコントロールコネクションの構成に関するヒント
DDEコントロール・コネクション・サービスのインスタンスを作成する

と、新しいデータポイントを追加したり、既存のデータポイントを編集

したり、不要のデータポイントを削除することができます。DDEコント

ロールコネクションの構成に関するヒントを以下に示します。

データポイントを追加するデータポイントを追加するデータポイントを追加するデータポイントを追加する
DDEアイテムまたはタグ名を指定することにより、データポイントを追

加することができます。タグのリストは、RSLogix5などのプログラミン

グソフトウェアにより作成されるタグファイルから入手することができ

ます。ユーザが作成したシンボルファイル (*.CSV)からタグを指定する

こともできます。タグ名で指定したデータポイントのアドレスは実行時

に決定されるため、データポイントのアドレスが将来変更されても、

RSSql のデータポイントを変更する必要がありません。従って、データポ

イントをタグ名で指定することをお奨めします。
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データポイントを追加する際に、コレクションのタイプ、タイムアウト

プロパティ、および代替えオプションなどのコレクションパラメータを

指定することができます。各データポイントには現在のコレクションパ

ラメータが適用されるため、コレクションのタイプ、タイムアウトプロ

パティ、および代替えオプションが追加するデータポイントに適してい

るかどうかを確認してください。各データポイントのプロパティは、後

で編集することもできます。

追加したデータポイントは、ダイアログのデータポイントリストに表示

されます。これらのデータポイントは、すべて同じインスタンス、サー

バ、およびトピックを持ちます。別のトピックを選択すると、そのト

ピックに関連のあるデータポイントのみが表示されます。別のサーバや

インスタンスを選択した場合も同様です。

あるインスタンス /サーバ /トピックの組合せについてデータポイントを

作成した後で、新しいタグファイルを選択すると、そのタグファイルは

そのインスタンス /サーバ /トピックのすべてのデータポイントにカス

ケードされます。別のサーバまたはトピックのデータポイントのデータ

を収集するために、新しい DDEコントロールコネクションを作成する必

要はありません。新しいサーバまたはトピックを選択して、データポイ

ントを追加するだけです。

連続する複数のデータポイントを追加する連続する複数のデータポイントを追加する連続する複数のデータポイントを追加する連続する複数のデータポイントを追加する
連続する複数のデータポイントを追加する場合、ショートカットを使用

することができます。例えば、連続する 7つのデータポイント N7:0～

N7:6を追加する場合、DDEアイテムとして N7:0,7を入力します。Apply

をクリックすると、7つのデータポイントが構成に追加されます。

連続する複数のエレメントを追加する連続する複数のエレメントを追加する連続する複数のエレメントを追加する連続する複数のエレメントを追加する
連続する複数のエレメント (例：ブロックデータなど )を追加する場合、

別のショートカットを使用することができます。例えば、連続する 10個

のエレメントを持つデータポイントを追加する場合、N7:0,L10と入力し

ます。この機能は、データ・テーブル・ファイルでは使用可能ですが、

構造では使用できません (例： T3:0.ACC,L8は使用できません )。データ

ポイント当たりの最大エレメント数は、512バイトです。
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ブロックデータ付きのデータポイントを構成すると、様々な方法でこれ

を使用することができます。連続するデータセットがそれ自体で意味を

持つ場合、これを直接的に使用することができます。例えば、PLCプロ

セッサの ASCIIレジスタに連続するセットが定義されている場合、トラ

ンザクションで使用すると、このデータポイントには完全な文字列が

入っています。

一方、PLCプロセッサの連続する複数のレジスタに、様々なデータタイ

プを持つ連続する複数のエレメントが定義されている場合、RSSqlの

Parse()関数により、文字列から各エレメントを取り出すことができます。

タグ名により複数のデータポイントを追加するタグ名により複数のデータポイントを追加するタグ名により複数のデータポイントを追加するタグ名により複数のデータポイントを追加する
別のプログラムにより作成されたタグファイルがある場合、そのタグ

ファイルのデータを使用して、RSSqlの構成に複数のデータポイントを追

加することができます。これを行なうには、DDE Data Point Configuration

ダイアログで Import Tag Symbolsボタンをクリックします。次に、タグ

ファイルでタグ名を選択します。

RSView32 コントロールコネクションRSView32 コントロールコネクションRSView32 コントロールコネクションRSView32 コントロールコネクション
RSView32コントロール・コネクション・サービスは、RSView32のデー

タを収集して、そのデータを RSSqlトランザクションマネージャで使用

できるようにするための NTサービスです。RSViewプロジェクトがオー

プンしていれば、RSSqlで RSViewのタグを参照して、RSView32コント

ロールコネクションにデータポイントを追加することができます。これ

を行なうには、RSViewプロジェクトが実行中である必要はありません。



38  �  Getting Results with RSSql

次に、RSViewコントロール・コネクション・サービスのインスタンスを

作成および構成する方法について説明します。RSView32コントロールコ

ネクションを作成および構成するには、1つ以上の RSSql変更権限を持っ

ている必要があります。適切な権限をお持ちでない場合、システム管理

者に相談してください。

RSView32コントロール・コネクション・サービスコントロール・コネクション・サービスコントロール・コネクション・サービスコントロール・コネクション・サービス
のインスタンスを作成するのインスタンスを作成するのインスタンスを作成するのインスタンスを作成する
RSViewコントロールコネクションのインスタンスを作成する

には、以下を実行します。

1. ツリービューで RSView Connectionを選択して、RSSqlメニューで

Define > Service Instanceを選択します。これにより、Service Instance

ダイアログが表示されます。

2. Service Nameフィールドで RSView Connectionが選択されていない場

合、RSView Connectionを選択します。

3. RSViewコントロールコネクションのインスタンス名 (このコネク

ションの名前 )、ホスト名、ユーザ名、およびパスワード名を指定し

ます。デフォルトのホスト名およびユーザ名は、それぞれ現在のコン

ピュータおよび現在のユーザです。

4. 設定が終了したら、Applyをクリックして、選択内容を保存します。

5. さらに別の RSViewコントロールコネクションを構成するには、ス

テップ 3～ 4を繰返します。

6. 作業が終了したら、Closeをクリックします。これにより、作成した

RSViewコントロールコネクションがツリービューに追加されます。

編集ボックスやリストボックスなどの画面エレメントに関す

る詳しい情報を参照するには、コンテキスト依存ヘルプを使

用してください。ヘルプを参照するための 1つの方法は、ヘ

ルプを参照したい画面エレメントの上にカーソルを置いて、

F1キーを押します。

TIP
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RSView32コントロールコネクションを構成するコントロールコネクションを構成するコントロールコネクションを構成するコントロールコネクションを構成する
RSViewコントロールコネクションのインスタンスを構成するには、以下

を実行します。

1. ツリービューで構成したい RSView Connectionを選択して、RSSqlメ

ニューで Define > Service Instance Dataを選択します。これにより、

RSView Data Point Configurationダイアログが表示されます。

2. RSViewコネクションのインスタンス名およびプロジェクト名を選択

します。(タグシンボルにアクセスするには、RSViewが実行中で、

プロジェクトがオープンしている必要があります。)

3. Select RSView Tagsをクリックすると、Select RSView Tagsダイアログ

が表示されます。(リストには、現在オープンしている RSViewプロ

ジェクトのシンボルのみが表示されます。)

4. Collection Parametersをクリックすると、Collection Parametersダイア

ログが表示されます。

5. コレクションのタイプ、タイムアウトプロパティ、および代替えオプ

ションを選択します。

6. OKをクリックすると、RSView32 Tags Data Point Configurationダイア

ログに戻ります。

7. データポイントとして定義する RSViewタグを選択して、タグのリス

トにそのタグを追加します。

8. Applyをクリックすると、選択内容が保存されます。

9. 設定が終了したら、Closeをクリックします。

RSView32コントロールコネクションの構成に関するヒントコントロールコネクションの構成に関するヒントコントロールコネクションの構成に関するヒントコントロールコネクションの構成に関するヒント
RSView32コントロール・コネクション・サービスのインスタンスを作成

すると、新しいデータポイントを追加したり、既存のデータポイントを

編集したり、不要のデータポイントを削除することができます。

RSView32コントロールコネクションの構成に関するヒントを以下に示し

ます。
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RSView32からタグをインポートするからタグをインポートするからタグをインポートするからタグをインポートする
RSSqlで RSView32のタグを参照および選択するには、RSSqlと

RSView32が同じコンピュータ上で実行されており、希望する RSView32

プロジェクトがオープンしている必要があります。このプロジェクトが

実行中である必要はありません。

データポイントを追加する場合、タイムアウトプロパティ、コレクショ

ンの方法、および代替えオプションなどの RSSqlコレクションパラメー

タを指定することができます。追加したデータポイントは、ダイアログ

のデータポイントリストに表示されます。これらのデータポイントは、

いずれも同じインスタンスおよび RSView32プロジェクトを使用します。

別のプロジェクトを選択すると、そのプロジェクトのデータポイントの

みが表示されます。

RSSqlおよび RSView32の現在のリリースでは、RSSqlが DCOMを介し

て リモートコンピュータ上で実行中の RSView32プロジェクトのタグを

参照および入力することはできません。
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Chapter

RSSqlエンタープライズコネクションエンタープライズコネクションエンタープライズコネクションエンタープライズコネクション
を構成するを構成するを構成するを構成する

RSSqlトランザクションマネージャとデータベースとの間のデータ交換

は、1つまたは複数の RSSqlエンタープライズコネクションにより行なわ

れます。各 RSSql構成は、1つ以上の有効なエンタープライズコネクショ

ンを持っていなければなりません。

現在、Open Database Connectivity (ODBC)および Oracle Callable Interface 

(OCI)という 2種類のエンタープライズコネクションがあります。どちら

もWindows NTサービスであり、双方向のデータ転送をサポートしてい

ます。この章では、これらのエンタープライズコネクションのインスタ

ンスを作成および構成する方法について説明します。

構成を行なう前に構成を行なう前に構成を行なう前に構成を行なう前に
RSSqlエンタープライズコネクションを構成する場合、データベースオブ

ジェクトの RSSqlビューを構成します。アクセスするデータベース

ビューは、レコードのデータベースユーザ (RSSqlエンタープライズコネ

クションの構成で指定したデータベースのユーザ名およびパスワード )に

よって異なります。データベースと RSSqlはまったく異なる環境へのア

クセスを制御しているため、データベースのユーザ名およびパスワード

は RSSqlのユーザ名およびパスワードと同じではないことに注意してく

ださい。

RSSqlのデータビューを構成する前に、エンタープライズ

データベースの 1つ以上のデータベースオブジェクトへのア

クセスを持っている必要があります。アクセスを持っていな

い場合、データベース管理者に相談してください。

TIP
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Oracleデータベースに接続するには、2つの方法があります。1つは、

RSSqlの OCIエンタープライズコネクションを介して接続する方法です。

もう 1つの方法は、RSSqlの ODBCエンタープライズコネクションを介

して接続する方法です。どちらの方法を使用しても、ローカルまたはリ

モートコンピュータ上の Oracleデータベースに接続することができます

が、OCIによる接続を強くお奨めします。

Data View Configurationダイアログで Convertをクリックすることにより、

RSSqlのデータビューを ODBCから OCIに、または OCIから ODBCに変

換することができます。変換については、オンラインヘルプを参照して

ください。

ODBC エンタープライズコネクションODBC エンタープライズコネクションODBC エンタープライズコネクションODBC エンタープライズコネクション
RSSqlの ODBCエンタープライズコネクションは、RSSqlトランザク

ションマネージャが作成したログファイルを処理して、SQL準拠データ

ベースなどの ODBC準拠ディスティネーションに新しいレコードを挿入

したり、既存のレコードを更新するための NTサービスです。

この項では、ODBCエンタープライズ・コネクション・サービスのイン

スタンスを作成および構成する方法について説明します。ODBCエン

タープライズコネクションを作成および構成するには、1つ以上の RSSql

変更権限を持っている必要があります。適切な権限をお持ちでない場合、

システム管理者に相談してください。

編集ボックスやリストボックスなどの画面エレメントに関す

る詳しい情報を参照するには、コンテキスト依存ヘルプを使

用してください。ヘルプを参照するための 1つの方法は、ヘ

ルプを参照したい画面エレメントの上にカーソルを置いて、

F1キーを押します。

TIP
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ODBCエンタープライズ・コネクション・サービスエンタープライズ・コネクション・サービスエンタープライズ・コネクション・サービスエンタープライズ・コネクション・サービス
のインスタンスを作成するのインスタンスを作成するのインスタンスを作成するのインスタンスを作成する
ODBCエンタープライズコネクションを構成するには、以下を実行しま

す。

1. ツリービューで ODBC Connectionを選択して、RSSqlメニューで

Define > Service Instanceを選択します。これにより、Service Instance

ダイアログが表示されます。

2. Service Nameフィールドで ODBC Connectionが選択されていない場

合、ODBC Connectionを選択します。

3. ODBCエンタープライズコネクションのインスタンス名、ホスト名、

ユーザ名、およびパスワードを指定します。デフォルトのホスト名お

よびユーザ名は、それぞれ現在のコンピュータおよび現在のユーザで

す。

4. Optionsをクリックすると、Enterprise Connection Parametersダイアロ

グが表示されます。

5. Log Files groupでエンタープライズコネクションのログファイルのパ

スおよびベース名を指定します。

6. Maximum Values groupで、ログファイル当たりの最大トランザクショ

ン数およびログファイル間の最大時間について、デフォルト値を受入

れるか、または新しい値を入力します。

7. 設定が終了したら、OKをクリックします。これにより、Enterprise 

Connection Parametersダイアログに戻ります。

8. Applyをクリックすると、変更内容が保存されます。

9. さらに別の ODBCエンタープライズコネクションを構成するには、

ステップ 3～ 8を繰返します。

10. 作業が終了したら、Closeをクリックします。これにより、作成した

ODBCエンタープライズコネクションがツリービューに追加されま

す。
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ODBCエンタープライズコネクションを構成するエンタープライズコネクションを構成するエンタープライズコネクションを構成するエンタープライズコネクションを構成する
ODBCエンタープライズコネクションを構成するには、以下を実行しま

す。

1. ツリービューで構成する ODBCコネクションを選択して、RSSqlメ

ニューで Define > Service Instance Dataを選択します。これにより、

Data View Configurationダイアログが表示されます。

2. Database groupでデータベースコネクションをリストから選択します。

(リストにコネクションが表示されない場合、Browseボタンをクリッ

クすると、Connectionsダイアログが表示されます。詳細は、後述の

「ODBCコネクションを作成する」の項を参照してください。) 

3. データテーブルまたはストアドプロシージャのリストのどちらを参照

するかを選択します。チェックボックスでオプションを選択すること

もできます。

4. 使用するデータテーブルまたはストアドプロシージャを選択します。

(新しいストアドプロシージャを作成する場合、後述の「ストアドプ

ロシージャを作成する」の項を参照してください。)

5. Data View groupで、データビューの名前を入力します。次に、データ

ビューで使用する ODBCサービスインスタンスを選択します。デー

タテーブルからデータビューを作成する場合、データベースで新しい

レコードを挿入するか、既存のレコードを更新するかを選択します。

6. 左側のウィンドウで、データビューで使用するカラムまたは引数を選

択して、データビューに追加すると、右側のウィンドウに表示されま

す。(データビューでは、すべてのカラムが「 NULLではなく」、ス

トアドプロシージャが入力されていなければなりません。)

7. 更新モードを選択した場合、右側のウィンドウでカラムを選択して、

右クリックして、メニューから属性を選択することにより、更新の属

性を変更することができます。

8. Applyをクリックすると、変更内容が保存されます。

9. さらに別のデータビューを構成するには、ステップ 2～ 8を繰返しま

す。

10. 作業が終了したら、Closeをクリックします。
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ODBCコネクションを作成するコネクションを作成するコネクションを作成するコネクションを作成する
ODBCコネクションを作成するには、以下を実行します。

1. Database Connectionダイアログで、コネクションの名前を入力しま

す。

2. DSNを選択します。(リストに DSNが表示されない場合、Browseボ

タンをクリックすると、ODBC Data Source Administratorが起動しま

す。詳細は、付録 Cを参照してください。)

3. データベースにアクセスするためのユーザ名およびパスワードを入力

します。

4. 現在の選択内容を受入れる前に Testをクリックして、接続を確認す

ることができます。選択内容を確認したら、Applyをクリックして、

選択内容を保存します。

5. さらに別の ODBCコネクションを作成するには、ステップ 1～ 4を

繰返します。

6. 作業が終了したら、Closeをクリックします。

ストアドプロシージャを作成するストアドプロシージャを作成するストアドプロシージャを作成するストアドプロシージャを作成する
ストアドプロシージャを作成するには、以下を実行します。

1. ツリービューで ODBCまたは OCIエンタープライズコネクションを

選択して、RSSqlメニューで Define > Service Instance Dataを選択し

ます。これにより、Data View Configurationダイアログが表示されま

す。

2. Database groupでコネクションを選択して、Stored Procedureを選択

します。最後に、Wizardをクリックして、画面の指示に従います。

3. 設定が終了したら、Applyをクリックして、選択内容を保存します。

4. Closeをクリックすると、ダイアログがクローズします。
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ODBCエンタープライズコネクションの構成に関するヒントエンタープライズコネクションの構成に関するヒントエンタープライズコネクションの構成に関するヒントエンタープライズコネクションの構成に関するヒント
ODBCエンタープライズ・コネクション・サービスのインスタンスを作

成すると、新しいデータビューを追加したり、既存のデータビューを編

集したり、不要のデータビューを削除することができます。ODBCエン

タープライズコネクションの構成に関するヒントを以下に示します。

データソース名データソース名データソース名データソース名
RSSqlの ODBCエンタープライズコネクションには、ODBCデータソー

スに接続するデータソース名 (DSN)が必要です。その結果、RSSqlトラ

ンザクションビルダ GUIにはシステムの DSNのみが表示されます。

OCI エンタープライズコネクションOCI エンタープライズコネクションOCI エンタープライズコネクションOCI エンタープライズコネクション
RSSqlの OCIエンタープライズコネクションは、RSSqlトランザクション

マネージャが作成したログファイルを処理して、Oracle7または Oracle8

データベースに新しいレコードを挿入したり、既存のレコードを更新す

るための NTサービスです。

この項では、OCIエンタープライズ・コネクション・サービスのインス

タンスを作成および構成する方法について説明します。OCIエンタープ

ライズコネクションを作成および構成するには、1つ以上の RSSql変更権

限を持っている必要があります。適切な権限をお持ちでない場合、シス

テム管理者に相談してください。

編集ボックスやリストボックスなどの画面エレメントに関す

る詳しい情報を参照するには、コンテキスト依存ヘルプを使

用してください。ヘルプを参照するための 1つの方法は、ヘ

ルプを参照したい画面エレメントの上にカーソルを置いて、

F1キーを押します。

TIP
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OCIエンタープライズ・コネクション・サービスエンタープライズ・コネクション・サービスエンタープライズ・コネクション・サービスエンタープライズ・コネクション・サービス
のインスタンスを作成するのインスタンスを作成するのインスタンスを作成するのインスタンスを作成する
OCIエンタープライズコネクションのインスタンスを作成するには、以

下を実行します。

1. ツリービューで NT Oracle OCI Connectionを選択して、RSSqlメ

ニューで Define Service Instanceを選択します。これにより、Service 

Instanceダイアログが表示されます。

2. Service Nameフィールドで NT Oracle OCI Connectionが選択されて

いない場合、NT Oracle OCI Connectionを選択します。

3. OCIエンタープライズコネクションのインスタンス名、ホスト名、

ユーザ名、およびパスワードを指定します。デフォルトのホスト名お

よびユーザ名は、それぞれ現在のコンピュータおよび現在のユーザで

す。

4. Optionsをクリックすると、Enterprise Connection Parametersダイアロ

グが表示されます。

5. Log Files groupでログファイルのパスおよびベース名を指定します。

6. Maximum Values groupで、ログファイル当たりの最大トランザクショ

ン数およびログファイル間の最大時間について、デフォルト値を受入

れるか、または新しい値を入力します。

7. 設定が終了したら、OKをクリックします。これにより、Enterprise 

Connection Parametersダイアログに戻ります。

8. Applyをクリックすると、変更内容が保存されます。

9. さらに別の OCIエンタープライズコネクションを作成するには、ス

テップ 3～ 8を繰返します。

10. 作業が終了したら、Closeをクリックします。これにより、作成した

OCIエンタープライズコネクションがツリーに追加されます。



48  �  Getting Results with RSSql

OCIエンタープライズコネクションを構成するエンタープライズコネクションを構成するエンタープライズコネクションを構成するエンタープライズコネクションを構成する
OCIエンタープライズコネクションを構成するには、以下を実行します。

1. ツリービューで構成する OCIコネクションを選択して、RSSqlメ

ニューで Define > Service Instance Dataを選択します。これにより、

SQL*NET Data View Configurationダイアログが表示されます。

2. Database groupでデータベースコネクションをリストから選択します。

(リストにコネクションが表示されない場合、Browseボタンをクリッ

クすると、Connectionsダイアログが表示されます。詳細は、後述の

「OCIコネクションを作成する」の項を参照してください。)

3. データテーブルまたはストアドプロシージャのリストのどちらを参照

するかを選択します。チェックボックスでオプションを選択すること

もできます。

4. 使用するデータテーブルまたはストアドプロシージャを選択します。

(新しいストアドプロシージャを作成する場合、後述の「ストアドプ

ロシージャを作成する」の項を参照してください。)

5. Data View groupで、データビューの名前を入力します。次に、データ

ビューで使用する OCIサービスインスタンスを選択します。データ

テーブルからデータビューを作成する場合、データベースで新しいレ

コードを挿入するか、既存のレコードを更新するかを選択します。

6. 左側のウィンドウで、データビューで使用するカラムまたは引数を選

択して、データビューに追加すると、右側のウィンドウに表示されま

す。(データビューでは、すべてのカラムが「 NULLではなく」、ス

トアドプロシージャが入力されていなければなりません。)

7. 更新モードを選択した場合、右側のウィンドウでカラムを選択して、

右クリックして、メニューから属性を選択することにより、更新の属

性を変更することができます。

8. Applyをクリックすると、変更内容が保存されます。

9. さらに別のデータビューを構成するには、ステップ 2～ 8を繰返しま

す。

10. 作業が終了したら、Closeをクリックします。
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OCIコネクションを作成するコネクションを作成するコネクションを作成するコネクションを作成する
OCIコネクションを作成するには、以下を実行します。

1. Database Connectionダイアログで、コネクションの名前を入力しま

す。

2. データベースのエイリアスを選択します。(リストにエイリアスが表

示されない場合、システム管理者に相談してください。)

3. データベースにアクセスするためのユーザ名およびパスワードを入力

します。

4. 現在の選択内容を受入れる前に Testをクリックして、接続を確認す

ることができます。選択内容を確認したら、Applyをクリックして、

選択内容を保存します。

5. さらに別の OCIコネクションを作成するには、ステップ 1～ 4を繰

返します。

6. 作業が終了したら、Closeをクリックします。

SQL*NETデータベースのエイリアスを作成するデータベースのエイリアスを作成するデータベースのエイリアスを作成するデータベースのエイリアスを作成する
OCIエンタープライズコネクションでは、SQL*NETコネクションを使用

します。SQL*NETコネクションは、"ORACLE_HOME"で定義した

Oracleルートディレクトリの下の ADMIN\NETWORKディレクトリ

(Oracle7.*)または NET80\ADMIN (Oracle8.*)ディレクトリの

TNSNAMES.ORAファイルで定義されます。RSSqlユーザインターフェイ

スは、このファイルを解析して、SQL*NETコネクションのリストを表示

します。

SQL*NETファイルを作成するにはいくつかの方法がありますが、Oracle

およびロックウェル・ソフトウェアは、Oracle Network Manager 

(Oracle7.*)または Oracle Net8 Easy Configurationを使用することをお奨め

します。SQL*NETコネクションファイル (TNSNAME.ORA)、ならびに

データベース・クライアント・ソフトウェアが必要とするファイル

(SQLNET.ORAおよび LISTENER.ORA)を作成するためのWindowsアプ

リケーションがあります。
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Chapter

RSSqlのトランザクションを構成するのトランザクションを構成するのトランザクションを構成するのトランザクションを構成する

この章では、RSSqlのトランザクションを構成する方法について説明しま

す。トランザクションを構成するには、RSSql変更権限を 1つ以上持って

いる必要があります。適切な権限をお持ちでない場合、システム管理者

に相談してください。

トランザクションを構成するトランザクションを構成するトランザクションを構成するトランザクションを構成する
トランザクションを構成するには、以下を実行します。 

1. RSSqlメニューで Define > Transactionを選択します。これにより、

Transaction Configurationダイアログが表示されます。

2. トランザクション名を指定します。

3. データビュー名、トランザクションのタイムアウト、およびトランザ

クションのステータスを選択します。

4. Trigger/Storage をクリックすると、Trigger and Storage Parametersダイ

アログが表示されます。

5. トランザクションのトリガを選択します。

6. トランザクションの格納方法を選択します。 

7. OKをクリックすると、Transaction Configurationダイアログに戻りま

す。

8. グリッドコントロールで、データビューのカラムまたはパラメータを

右クリックします。カラムまたはパラメータをデータポイントまたは

演算式に結び付けるかどうかを選択します。演算式を選択した場合、

Expression Editorにより演算式を作成します。

9. すべてのカラムおよびパラメータについてステップ 8を繰返します。

編集ボックスやリストボックスなどの画面エレメントに関す

る詳しい情報を参照するには、コンテキスト依存ヘルプを使

用してください。ヘルプを参照するための 1つの方法は、ヘ

ルプを参照したい画面エレメントの上にカーソルを置いて、

F1キーを押します。

TIP
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10. Apply をクリックすると、選択内容が保存されます。

11. さらに別のトランザクションを構成するには、ステップ 2～ 9を繰返

します。 

12. 作業が終了したら、Closeをクリックします。

RSSql のトランザクションRSSql のトランザクションRSSql のトランザクションRSSql のトランザクションの構成に関するヒントの構成に関するヒントの構成に関するヒントの構成に関するヒント

RSSqlのトランザクションの構成に関するヒントを以下に示します。 

トランザクションデータ収集トリガトランザクションデータ収集トリガトランザクションデータ収集トリガトランザクションデータ収集トリガ
データ収集トリガとして、定期イベント、不定期イベント、または

Visual Basicなどのアプリケーションプログラムからの関数呼出しがあり

ます。

定期イベントは、タイムベースのイベントです。例えば、シフトの開始

時、月末、毎週金曜日の午後 3:30などは定期イベントです。スケジュー

ラスレッドは、タイムベースイベントのスケジューリングを行ないます。

定期イベントは、RSSql イベントスケジューラにより定義することができ

ます。 

不定期イベントは、 PLCからのアンソリシテッドメッセージや DDEホッ

トリンクからのデータ値の更新など、外部ソースから受取るイベントで

す。不定期イベントを使用すると、制御システムの大量のデータをリン

ク経由で企業データベースに送ることができます。

トランザクションの格納方法トランザクションの格納方法トランザクションの格納方法トランザクションの格納方法
データ格納トリガは、トランザクションが終了した場合、演算結果が

True(真 )になった場合、指定した数のトランザクションが発生した場合、

またはデータ値が変更した場合のいずれかです。 これらのオプションによ

り、トランザクションをいつ格納するかを制御することができます。

エンタープライズコネクションに送信されたデータを、トランザクショ

ンの終了時に格納するように選択することができます。(リアルタイムで

はなく )ロギングを実行して、エンタープライズコネクションのログファ

イル送信基準を満たすと、トランザクション内のログファイルは RSSql

エンタープライズコネクションに送信されます。
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また、RSSqlの演算式エディタにより演算式を作成して、真 (ゼロではな

い )または偽 (0)を評価することもできます。例えば、データポイントの

値が特定の値を上回った場合にデータ格納を行なうことができます。

指定した数のトランザクションが発生するまでデータ格納を行なわない

ように選択することもできます。このオプションは、演算のトレンドに

役立ちます。例えば、このオプションを使用すると、結果を歪める原因

となる最初のいくつかのトランザクションを無視することができます。

値の変更時にデータ格納を行なうよう選択することもできます。この方

法を使用すると、トランザクションを 5分ごとに実行して、値の変更時

または一定時間の経過後にデータをデータベースに格納することができ

ます。

イベントスケジューラを使用するイベントスケジューラを使用するイベントスケジューラを使用するイベントスケジューラを使用する
RSSqlイベントスケジューラにより、ユーザ独自の定期イベントを作成す

ることができます。スケジューラにアクセスするには、Trigger and 

Storage Parametersダイアログで Schedulerボタンをクリックします。これ

により、Event Configurationダイアログが表示されます。

定期イベントを作成するには、以下を実行します。

1. 作成する定期イベントの名前を指定します。 

2. イベントのタイプを選択します。

3. どのような場合にイベントを発生させるかを指定します。

4. Applyをクリックすると、選択内容が保存されます。

5. さらに別の定期イベントを作成するには、ステップ 1～ 4を繰返しま

す。

6. 作業が終了したら、Closeをクリックします。

演算式エディタを使用する演算式エディタを使用する演算式エディタを使用する演算式エディタを使用する
RSSql演算式エディタを使用して、ユーザ独自の演算式を作成することが

できます。演算式エディタにアクセスするには、Trigger and Storage 

Parametersダイアログで On True Expressionsを選択します。次に、演算式

編集ボックスの右側にある Browseボタンをクリックします。 これによ

り、Expression Editorダイアログが表示されます。
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演算式を作成するには、以下を実行します。

1. 演算関数を選択します。

2. 演算子を選択します。

3. 演算式で使用するデータポイントを選択します。

4. Validateをクリックして、演算式をテストします。

5. 作業が終了したら、Closeをクリックします。
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RSSqlソフトウェアを使用するソフトウェアを使用するソフトウェアを使用するソフトウェアを使用する

RSSqlの構成を作成して、コントロールコネクションを構成して、エン

タープライズコネクションを構成して、トランザクションを構成したら、

RSSqlソフトウェアを開始して、 PLCプロセッサのデータテーブルから

データベースにデータを移動することができます。データビューの構成

によって、データベースに新しいレコードを挿入したり、既存のレコー

ドを更新したり、ストアドプロシージャを呼出すことができます。

この章では、RSSqlソフトウェアの使用方法について説明します。

RSSql を開始および停止するRSSql を開始および停止するRSSql を開始および停止するRSSql を開始および停止する
RSSqlプロジェクトに複数の構成が入っていても、1つのサービスで使用

できる構成は 1つだけです。RSSqlツリービューの信号機アイコンは、プ

ロジェクト内の各 RSSqlサービスのステータスを示します。

信号機が緑色の場合、サービスは実行中です。信号機が赤色の場合、

サービスが実行中ではありません。信号機が黄色の場合、構成内のいず

れかのコントロール・コネクション・サービスまたはエンタープライズ

コネクションが実行中ではありません。

RSSqlの構成全体を開始および停止するには、アクティブな構成内の

RSSqlコントロールおよびエンタープライズコネクションを開始および停

止します。

RSSqlの構成を開始および停止するには、RSSql管理者権限を

持っている必要があります。また、ネットワーク上の複数の

コンピュータで RSSqlが実行中である場合、RSSqlサービス

がインストールされている各コンピュータに対して NT管理

者権限を持っている必要があります。適切な権限をお持ちで

ない場合、システム管理者に相談してください。

TIP
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構成を開始する構成を開始する構成を開始する構成を開始する
構成を開始するには、以下を実行します。

1. ツリービューで開始する構成を選択します。

2. RSSqlメニューで Configuration > Startを選択します。

3. 構成を開始することを認める場合、Yesをクリックします。

構成を停止する構成を停止する構成を停止する構成を停止する
構成を停止するには、以下を実行します。

1. ツリービューで停止する構成を選択します。

2. RSSqlメニューで Configuration > Stopを選択します。

3. 構成を停止することを認める場合、Yesをクリックします。

コネクションを開始するコネクションを開始するコネクションを開始するコネクションを開始する
コントロールコネクションまたはエンタープライズコネクションを開始

するには、以下を実行します。

1. 実行中の構成の下のツリービューで、開始するコネクションを選択し

ます。

2. RSSqlメニューで Configuration > Startを選択します。

3. コネクションを開始することを認める場合、Yesをクリックします。

コネクションを停止するコネクションを停止するコネクションを停止するコネクションを停止する
コントロールコネクションまたはエンタープライズコネクションを停止

するには、以下を実行します。

1. 実行中の構成の下のツリービューで、終了するコネクションを選択し

ます。

2. RSSqlメニューで Configuration > Stopを選択します。

3. コネクションを停止することを認める場合、Yesをクリックします。
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トランザクションをモニタするトランザクションをモニタするトランザクションをモニタするトランザクションをモニタする
アクティブな構成用に定義したすべてのトランザクションの動作をモニ

タすることができます。

ワークスペースに表示する情報のタイプを変更するには、以下を実行し

ます。

1. RSSqlメニューで Viewを選択します。

2. メニューで Transaction Configuration, Configuration Log Files, または

Transaction Monitorを選択します。

3. さらにビューを変更するには、ステップ 1～ 2を繰返します。

構成のログファイルを参照する構成のログファイルを参照する構成のログファイルを参照する構成のログファイルを参照する
構成のログファイルを参照するには、RSSqlメニューで

View > Configuration Log Filesを選択します。

NTサービスのステータスを更新するサービスのステータスを更新するサービスのステータスを更新するサービスのステータスを更新する
NTサービスのステータスを更新するには、RSSqlメニューで

View > Services Status Updateを選択します。

ユーザの権限を変更するユーザの権限を変更するユーザの権限を変更するユーザの権限を変更する
ユーザの権限を変更するには、以下を実行します。

1. RSSqlメニューで Privilegesを選択します。

2. 次に、メニューで View, Modify, または Adminを選択します。

3. さらに権限を変更するには、ステップ 1～ 2を繰返します。

 RSSql トランザクションをモニタするには、RSSql参照権限

を 1つ以上持っている必要があります。適切な権限をお持ち

でない場合、システム管理者に相談してください。

TIP
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構成のバックアップおよびリストア構成のバックアップおよびリストア構成のバックアップおよびリストア構成のバックアップおよびリストア

バックアップコピーを作成するバックアップコピーを作成するバックアップコピーを作成するバックアップコピーを作成する
RSSql構成のバックアップコピー (ファイル拡張子はすべて *.DAT)を作

成するには、以下を実行します。

1. RSSqlメニューで Configuration > Backupを選択します。これによ

り、Save Asダイアログが表示されます。

2. RSSql構成ファイル (*.RSQ)の名前およびディレクトリを指定しま

す。ファイル拡張子は、ファイル名の後に自動的に追加されます。

3. 作業が終了したら、Saveをクリックします。

コピーを同じコンピュータにリストアするコピーを同じコンピュータにリストアするコピーを同じコンピュータにリストアするコピーを同じコンピュータにリストアする
RSSqlの構成を同じコンピュータにリストアするには、以下を実行しま

す。

1. RSSqlメニューで Configuration > Restoreを選択します。

2. Openダイアログで、RSSql構成ファイル (*.RSQ)をオープンします。

これにより、RSSql Configurationダイアログが表示されます。

3. RSSql構成ファイルの名前およびディレクトリを指定します。構成の

保存時とは異なるファイル名およびディレクトリを指定することもで

きます。Apply をクリックして、これらの入力内容を受入れます。

4. 構成をリストアすることを認める場合、Yesをクリックします。

コピーを別のコンピュータにリストアするコピーを別のコンピュータにリストアするコピーを別のコンピュータにリストアするコピーを別のコンピュータにリストアする
RSSqlの構成を別のコンピュータにリストアするには、以下を実行しま

す。

1. RSSqlメニューで Configuration > Restoreを選択します。

2. Openダイアログで RSSql構成ファイル (*.RSQ)をオープンします。

これにより、RSSql Configurationダイアログが表示されます。

3. RSSql構成ファイルの名前およびディレクトリを指定します。構成の

保存時とは異なるファイル名およびディレクトリを指定することもで

きます。Apply をクリックして、これらの入力内容を受入れます。
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4. 構成をリストアすることを認める場合、Yesをクリックします。これ

により、構成は RSSqlシステムに追加されます。ただし、このコン

ピュータおよびネットワークの設定に合わせて、ユーザアカウントお

よびログ・パス・パラメータを変更しなければなりません。

RSSqlは、ロギングディレクトリを作成しようとします。何らかの理

由によりロギングディレクトリを作成できない場合、メッセージが表

示されます。このような場合、ユーザが手動でディレクトリを作成し

なければなりません。

5. ツリーでリストアされた構成を右クリックして、Define Service 

Instanceを選択します。ホスト名、ユーザ名、およびパスワードがこ

のコンピュータ /ネットワーク用に正しく設定されているかどうかを

確認して、必要であれば修正を行ないます。

6. ツリーでリストアされた構成を右クリックして、Define 

Configuration Loggingを選択します。ログファイルのパスがこのコン

ピュータ /ネットワーク用に正しく設定されているかどうかを確認し

て、必要であれば修正を行ないます。

7. リストアされた構成の下で、各サービス・インスタンス・タイプを順

番に選択して、右クリックして、Define Service Instanceを選択しま

す。ホスト名、ユーザ名、およびパスワードがこのコンピュータ /

ネットワーク用に正しく設定されているかどうかを確認して、必要で

あれば修正を行ないます。さらに、エンタープライズ・コネクショ

ン・タイプのインスタンスについて、ログファイルのパスがこのコン

ピュータ /ネットワーク用に正しく設定されているかどうかを確認し

ます。作業が終了すると、構成がリストアされ、新しい環境で動作で

きるようになります。

構成を使用する前に、DDEサーバ上の DDEトピックを再作

成して、システム DSNまたは SQL*NETデータベースエイリ

アスを再作成する必要があります。

TIP
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必要な情報を入手する必要な情報を入手する必要な情報を入手する必要な情報を入手する

RSSqlソフトウェアについて詳しく知りたい場合、以下をご利用くださ

い。

� オンラインヘルプ

� RSSqlのトレーニング

� テクニカルサポート

オンラインヘルプオンラインヘルプオンラインヘルプオンラインヘルプ
RSSqlオンラインヘルプは、RSSqlソフトウェアの概要、各種機能の実行

方法、および各コントロールに関するコンテキスト依存の定義について

説明します。RSSqlソフトウェアの実行中にオンラインヘルプを参照する

には、以下のいずれかを実行します。

� RSSqlグラフィックのボタンをクリックする 

� RSSqlメインウィンドウのメニューで Helpを選択する

� RSSqlダイアログで Helpボタンをクリックする

� ヘルプを参照したいコントロールにカーソルを移動して、F1キーを押

す

� Helpボタンをクリックして、ヘルプを参照したいコントロールをク

リックする

RSSql のトレーニングRSSql のトレーニングRSSql のトレーニングRSSql のトレーニング
ロックウェル・ソフトウェア製品をより有効に利用するための最良の方

法の 1つは、ロックウェル・ソフトウェアのトレーニングプログラムに

参加することです。当社のトレーニングプログラムは、当社のソフト

ウェアの基礎を理解して、ソフトウェアの機能を最大限に利用するのに

役立ちます。
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当社では、当社施設で定期的に実施しているトレーニングクラスから、

お客さまの施設で実施する特別のトレーニングクラスまで、幅広いト

レーニングプログラムを提供しています。いずれのクラスも少人数制で

行なわれるため、各参加者は十分に学習することができます。

トレーニングプログラムの詳細については、ロックウェル・ソフトウェ

アのWebサイトにアクセスするか、当社のトレーニング担当者までお問

合せください。

テクニカルサポートテクニカルサポートテクニカルサポートテクニカルサポート
本書およびオンラインヘルプを参照しても、問題を解決できない場合、

当社のテクニカルサポートまでお問い合わせください。
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Appendix

コピープロテクト機能コピープロテクト機能コピープロテクト機能コピープロテクト機能

ロックウェル・ソフトウェアのWindowsベースのアプリケーションプロ

グラムは、すべてコピープロテクトされています。プログラムを使用可

能にするには、固有のソフトウェアキーが必要です。プログラムを使用

可能にしないと、プログラムはデモモードで動作するか、またはまった

く動作しません。

この付録では、以下について説明します。

� コピープロテクト機能の概要

� ソフトウェアキーを移動する方法

� ソフトウェアキーが損傷している場合にリセットする方法

� マスタディスクをキーディスクとして使用する方法

コピープロテクト機能の概要コピープロテクト機能の概要コピープロテクト機能の概要コピープロテクト機能の概要
ロックウェル・ソフトウェアのアプリケーションプログラムを使用可能

にするには、固有のソフトウェアキーが必要です。ソフトウェアキーは、

プログラムに付属のマスタディスク上に格納されています。アクティ

ベーションファイルには、ライセンス当たり 1つのソフトウェアキーが

入っています。そのため、マスタディスク上のアクティベーションファ

イルには、複数のソフトウェアキーが入っていることがあります。各ソ

フトウェアキーは、同じシリアル番号を持つアプリケーションプログラ

ムに対応しています。

マスタディスクには、Move Activation (EVMOVE.EXE)および Reset 

Activation (RESET.EXE)という 2つのユーティリティプログラムも格納さ

れています。 これらのユーティリティは、マスタディスクに常駐してお

り、ハードディスク上にはインストールされません。Move Activation

ユーティリティにより、ソフトウェアキーをマスタディスクからハード

ディスクに移動したり、ハードディスクからマスタディスクに戻すこと

ができます。Reset Activationユーティリティにより、ソフトウェアキー

が損傷した場合にキーを修復することができます。
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アプリケーションプログラムをインストールすると、セットアッププロ

グラムはユーザに対して、該当するマスタディスクをフロッピー・ディ

スク・ドライブに挿入して、アクティベーションの方法を選択すること

により、アプリケーションプログラムを使用可能にするように、プロン

プトを表示します。

アプリケーションプログラムを使用可能にするには、以下の 3つの方法

があります。

� ソフトウェアキーをローカルなハード・ディスク・ドライブにコピー

する

� ソフトウェアキーをネットワークドライブにコピーする

� マスタディスクをキーディスクとして使用する

いずれの方法にも利点と制限事項があります。アプリケーションに最適

と思われる方法を選択してください。アプリケーション要件の変更に応

じて、アクティベーションの方法を後から簡単に変更することもできま

す。 

ソフトウェアキーを移動するソフトウェアキーを移動するソフトウェアキーを移動するソフトウェアキーを移動する
ソフトウェアキーは、以下のように移動することができます。

� マスタディスクからハード・ディスク・ドライブ (ローカルまたはネッ

トワーク )へ

� ハード・ディスク・ドライブからマスタディスクへ

ソフトウェアキー をローカルまたはネットワークドライブに移動するこ

とを選択すると、アクティベーションファイルは選択されたドライブ上

に作成されます。このファイルは、作成時の状態を保持しなければなり

ません。そうでないと、アプリケーションプログラムを使用可能にする

ことができません。したがって、作成されたアクティベーションファイ

ルを圧縮、編集、移動したり、名前を変更してはなりません。オペレー

ティングシステムをアップグレードする場合、アップグレードを実行す

る前に、ソフトウェアキーをマスタディスクに戻す必要があります。
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アップグレードが終了したら、キーを再びハード・ディスク・ドライブ

に移動して、アプリケーションプログラムを再び使用可能にすることが

できます。

アクティベーションの方法として最も一般的なのは、ソフトウェアキー

をローカルなハード・ディスク・ドライブに移動することです。1台のコ

ンピュータだけでアプリケーションプログラムを使用する場合、この方

法を使用します。ソフトウェアの初期インストール時にアプリケーショ

ンプログラムを使用可能にする場合、この方法がデフォルト設定されて

います。 

後に、アプリケーションプログラムを別のコンピュータで使用する場合、

ソフトウェアキーをマスタディスクにいったん戻してから、該当するコ

ンピュータのハードディスクにキーを移動しなければなりません。

ソフトウェアキーをマスタディスクからハード・ディスク・ドライブに

移動したり、ハード・ディスク・ドライブからマスタディスクに戻す方

法は、以下のとおりです。

1. アプリケーションプログラムのインストール先となるコンピュータの

3.5インチ・フロッピー・ディスク・ドライブにマスタディスクを挿

入します。

2. Move Activationユーティリティプログラムを開始します。

3. Fromボックスで、ソースドライブ (ソフトウェアキーが現在格納さ

れているドライブ )を選択します。Toボックスで、宛先ドライブ (ソ

フトウェアキーの移動先となるドライブ )を選択します。OKをク

リックします。

4. すべてのアクティベーションキーを移動する場合、Moveをクリック

します。

移動するアクティベーションキーの数を変更する場合、以下を実行し

ます。

1 RSSqlを選択して、Edit Selectedをクリックします。

2 Moveボックスで、移動するアクティベーションキーの数を入力

します。
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3 OKをクリックします。

4 Moveをクリックします。

このユーティリティの詳細は、オンラインヘルプを参照してください。

ソフトウェアキーをリセットするソフトウェアキーをリセットするソフトウェアキーをリセットするソフトウェアキーをリセットする
何らかの理由によりアクティベーションキーが損傷した場合、当社のテ

クニカルサポートにリセットコードをお問合せください。

当社へのお問合せは、使用可能なマスタディスクを用意して、PCの近く

で行なってください。アプリケーションプログラムがインストールされ

ている PCを使用する必要はありませんが、アプリケーションプログラム

に対応するシリアル番号が記載されたマスタディスクを用意してくださ

い。

当社のテクニカルサポート担当者は、マスタディスクからプロダクト ID

およびシステム IDを見つける方法を説明してから、ソフトウェアキーに

対してリセットコードを割当てます。当社のテクニカルサポートからリ

セットコードを取得したら、キーをリセットして、アプリケーションプ

ログラムを再び使用可能にします。

リセットコードによりキーを再び使用可能にする方法は、以下のとおり

です。

1. マスタディスクをフロッピー・ディスク・ドライブに挿入する。

2. A:\RESET.EXEまたは B:\RESET.EXEを実行します。Aまたは Bは、

マスタディスクが格納されているドライブです。

3. Reset Codeボックスでリセットコードを入力して、OKをクリックし

ます。

ソフトウェアのマスタディスクがないと、アクティベーショ

ンキーをリセットすることができません。ソフトウェアのマ

スタディスクは、必ず安全な場所に保管してください。

TIP
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マスタディスクをキーディスクとして使用するマスタディスクをキーディスクとして使用するマスタディスクをキーディスクとして使用するマスタディスクをキーディスクとして使用する
マスタディスクには、2つの主な機能があります。それは、アプリケー

ションプログラムのアクティベーションファイルを運搬することと、

キーディスクを作成することです。緊急時には、マスタディスクをキー

ディスクとして使用することができます。

いくつかの場合に、キーディスクによりアプリケーションプログラムを

使用可能にする必要があります。1つは、(ハード・ディスク・ドライブ

の故障、ハード・ディスク・ドライブ上のファイルの損傷などにより )ア

クティベーションファイルが損傷していて、アプリケーションプログラ

ムを使用できない場合です。もう 1つは、オフィスのデスクトップコン

ピュータとフィールドワーク用のポータブルコンピュータの両方でアプ

リケーションプログラムを使用する場合です。RSSqlを複数のコンピュー

タ (デスクトップコンピュータとポータブルコンピュータなど )で使用す

る場合、このアクティベーション方法を使用しなければなりません。 

セットアッププログラムを使用して、両方のコンピュータにソフトウェ

アをインストールしますが、Advanced Setup Optionsダイアログで Use Key 

Disksチェックボックスを確認します。アクティベーションファイルはマ

スタディスク上にあります。次に、EvMoveユーティリティにより、アク

ティベーションファイルをマスタディスクから別のフロッピーディスク

(キーディスク )に移動します。マスタディスクは安全な場所に保管して

ください。アプリケーションプログラムを使用するには、アプリケー

ションプログラムを実行するコンピュータ上のドライブにキーディスク

を挿入します。 
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Appendix

RSSqlののののWindows NTユーザグユーザグユーザグユーザグ
ループループループループ を作成するを作成するを作成するを作成する

RSSqlソフトウェアでは、Windows NTオペレーティングシステムのセ

キュリティ機能を使用します。各 RSSqlユーザ権限 (Admin, Modify, およ

び View)には、対応するWindows NTユーザグループ (RSSql_Admin, 

RSSql_Modify, および RSSql_View)があります。 RSSqlユーザの権限は、

ユーザがどのWindows NTユーザグループに属しているかによって異な

ります。RSSqlソフトウェアを構成および使用する前に、これらのユーザ

グループを作成して、ユーザをユーザグループに追加する必要がありま

す。

RSSqlソフトウェアを実行しているコンピュータが NTドメインの一部で

ある場合、RSSqlソフトウェアはドメインサーバ上のグローバル NTユー

ザアカウントをチェックすることにより、ユーザ権限を確認します。コ

ンピュータがネットワークに接続されていない (スタンドアロンシステム

である )場合、RSSqlソフトウェアはローカル NTユーザアカウントを

チェックすることにより、ユーザ権限を確認します。

この付録では、ローカル NTユーザグループおよびグローバル NTユーザ

グループを作成する方法について説明します。

ローカル・ユーザ・グループを作成するローカル・ユーザ・グループを作成するローカル・ユーザ・グループを作成するローカル・ユーザ・グループを作成する
このタスクを実行するには、Windows NTのシステム管理者権限を持って

いる必要があります。適切な権限をお持ちでない場合、システム管理者

に相談してください。

ローカル NTユーザグループを作成するには、以下を実行します。

1. Startをクリックして、メニューで Programs > Administrative Tools > 

User Managerを選択します。これにより、User Managerウィンドウ

が表示されます。

2. ユーザメニューで New Local Groupを選択します。これにより、

Local Groupダイアログが表示されます。
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3. Group Nameフィールドで RSSql_Adminを入力します。

4. ユーザアカウントを RSSqlユーザグループに追加する必要がありま

す。Addをクリックすると、このグループに他のユーザアカウント

が追加され、RSSqlを使用する権限がこれらのユーザアカウントに与

えられます。

5. すべてのユーザアカウントを RSSql_Admin groupに追加したら、OK

をクリックします。

6. さらに別の RSSqlユーザグループ (RSSql_Modifyおよび RSSql_View)

にユーザアカウントを追加するには、ステップ 2～ 5を繰返します。

7. ユーザアカウントの追加が終了したら、ウィンドウの下部に表示され

ている Administrators Local Groupをダブルクリックします。RSSqlの

サービスを開始および停止するには、ユーザが管理者権限を持ってい

る必要があるため、使用するユーザアカウントがこのグループのメン

バーかどうかを確認します。Addをクリックすると、このグループ

に他のユーザアカウントが追加されます。

8. 作業が終了したら、Closeをクリックします。

グローバル NT ユーザグループを作成するグローバル NT ユーザグループを作成するグローバル NT ユーザグループを作成するグローバル NT ユーザグループを作成する
グローバルな RSSqlユーザグループの作成、およびユーザグループへの

ユーザアカウントの追加は、Windows NTドメイン管理者によって行なわ

れなければなりません。ドメイン管理者は、Windows NT User Manager for 

Domainsアプリケーションを使用して、以下を行ないます。

� プライマリ・ドメイン・コントローラ (ドメインサーバ )上に、RSSqlの 3

つのグローバル NTユーザグループ (RSSql_Admin, RSSql_Modify, およ

び RSSql_View)を作成します。 

� すべての RSSqlユーザのユーザアカウントを該当するグローバル・ユー

ザ・グループに追加します。
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Appendix

ODBCデータソースを構成するデータソースを構成するデータソースを構成するデータソースを構成する

RSSqlの ODBCエンタープライズコネクションが ODBC準拠データベー

スを使用する前に、エンタープライズコネクションがデータベースと接

続するように、システム・データ・ソースを構成する必要があります。

この付録では、以下のデータソース名 (DSN)を構成する方法について説

明します。

� Microsoft SQL Server

� Microsoft Access

� Oracle7および Oracle8

編集ボックス、リストボックス、ラジオボタン、およびチェックボック

スなどの画面エレメントについての詳しい説明は、コンテキスト依存ヘ

ルプを参照してください。ヘルプを参照するための 1つの方法は、ヘル

プを参照したい画面エレメントにカーソルを移動して、F1キーを押すこ

とです。 

SQL Server の DSN を構成するSQL Server の DSN を構成するSQL Server の DSN を構成するSQL Server の DSN を構成する
SQL Serverへの接続を構成するには、以下を実行します。

1. Windows NTの制御パネルで ODBCアイコンをダブルクリックしま

す。これにより、ODBC Data Source Administratorウィンドウが表示さ

れます。

構成を開始する前に、インストールされている ODBC Data 

Source Administrator appletのバージョンを確認してください。

以下のプロシージャは、Ver. 3.0以降に適用されます。Ver. 3.0

以前の ODBC Data Source Administrator appletでは、タブを使

用できません。Ver. 3.0以前のバージョンをお持ちの場合、以

下に示すプロシージャをガイドラインとして使用することは

できますが、タブの代わりにボタンを使用しなければなりま

せん。

TIP
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2. System DSNタブをクリックします。これにより、システム・デー

タ・ソースのリストが表示されます。

3. 新しい ODBCコネクションを作成するには、 Addボタンをクリック

します。これにより、使用可能な ODBCドライバのリストが記載さ

れた Create New Data Sourceダイアログが表示されます。

4. SQL Serverドライバを選択して、 Finishボタンをクリックします。こ

れにより、ODBC SQL Server Setupダイアログが表示されます。

5. データソース名 (例：SQL_Server)を入力して、サーバリストから

SQL Serverを選択します。OKをクリックすると、コネクションが作

成され、ODBC Data Source Administratorウィンドウが再び表示されま

す。これで、Microsoft SQL Serverへの ODBC接続が構成され、 ODBC 

Data Source Administratorウィンドウの System DSNタブ のシステム・

データ・ソースのリストに記載されます。

ODBC SQL Server Setupダイアログの Logging Group Database Name

フィールドに、使用するデータベース名を入力することをお奨めしま

す。

6. 作業が終了したら、OKをクリックします。

SQL Serverの ODBCドライブのプロファイリング機能を使用

して、RSSqlドメインの外部のトラブルシューティング情報

を収集することができます。これを行なうには、ODBC SQL 

Server Setupダイアログで Optionsボタンをクリックして、

Profileボタンをクリックします。Save Log Running Queriesを

選択して、 Query Logging Thresholdを 1msecに設定して、各ク

エリのログが作成されるようにします。クエリの文字列は、

指定したクエリ・ログ・ファイルに保存されます。Notepadな

どのテキストエディタにより、このファイルを参照すること

ができます。 

TIP
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Microsoft Access の DSN を構成するMicrosoft Access の DSN を構成するMicrosoft Access の DSN を構成するMicrosoft Access の DSN を構成する
Microsoft Accessデータベースへの接続を構成するには、以下を実行しま

す。

1. Windows NTの制御パネルで ODBCアイコンをダブルクリックしま

す。これにより、ODBC Data Source Administratorウィンドウが表示さ

れます。

2. System DSNタブをクリックします。これにより、システム・デー

タ・ソースのリストが表示されます。

3. 新しい ODBCコネクションを作成するには、 Addボタンをクリック

します。これにより、使用可能な ODBCドライバのリストが記載さ

れた Create New Data Sourceダイアログが表示されます。 

4. Microsoft Accessドライバを選択して、 Finishボタンをクリックしま

す。これにより、ODBC Microsoft Access 97 Setup画面が表示されま

す。Microsoft Access 97を使用している場合、Ver. 3.5以降のドライバ

を使用する必要があります。 Ver. 3.5以前のドライバは使用できませ

ん。ドライバのリビジョンレベルを参照するには、ODBC Data Source 

Administratorウィンドウで ODBC Driversタブをクリックします。

5. Selectボタンをクリックします。これにより、Select Databaseダイア

ログが表示されます。 

6. 使用するデータベース (例：Local_Access.mdb)を選択して、OKをク

リックします。これにより、 ODBC Microsoft Access 97 Setup画面が再

び表示されます。

7. データソース名 (例：Access_Connection)を入力します。これにより、

選択したデータベースが表示されます。OKをクリックすると、コネ

クションが作成されます。これで、Microsoft Accessデータベースへ

の ODBC接続が構成され、 ODBC Data Source Administratorウィンドウ

の System DSNタブ のシステム・データ・ソースのリストに記載され

ます。

8. 作業が終了したら、OKをクリックします。
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Oracle の DSN を構成するOracle の DSN を構成するOracle の DSN を構成するOracle の DSN を構成する
Oracleデータベースへの接続を構成するには、以下を実行します。

1. Windows NTの制御パネルで ODBCアイコンをダブルクリックしま

す。これにより、ODBC Data Source Administratorウィンドウが表示さ

れます。

2. System DSNタブをクリックします。これにより、システム・デー

タ・ソースのリストが表示されます。

3. 新しい ODBCコネクションを作成するには、 Addボタンをクリック

します。これにより、使用可能な ODBCドライバのリストが記載さ

れた Create New Data Sourceダイアログが表示されます。

4. Oracle73または Oracle8.*ドライバを選択して、Finishボタンをク

リックします。これにより、Oracle ODBC Setupダイアログが表示さ

れます。

5. データソース名 (例：Oracle_Connection)を入力して、SQL *Netの構

成から、データベースのエイリアスとして SQL *Net Connect String

(例：rascal) を入力します。OKをクリックすると、コネクションが

作成されます。これで、Oracleデータベースへの ODBC接続が構成

され、 ODBC Data Source Administratorウィンドウの System DSNタブ 

のシステム・データ・ソースのリストに記載されます。

6. 作業が終了したら、OKをクリックします。
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RSLinx AdvancedDDEサーバを構サーバを構サーバを構サーバを構
成する成する成する成する

RSSqlコントロールコネクションが RSLinx AdvancedDDEサーバを使用す

る前に、RSLinxでデバイスドライバを構成して、 パーソナルコンピュー

タにインストールされている通信カードを使用できるようにすると共に、 

DDEトピックを構成して、プロセッサのデータテーブルに格納されてい

る情報に RSLinxがアクセスできるようにします。

この付録では、RSLinx Ver. 1.7でデバイスドライバおよび DDEトピック

を構成する方法について説明します。Ver. 1.7以外のバージョンを使用し

ている場合は、構成の方法が異なります。

編集ボックス、リストボックス、ラジオボタン、およびチェックボック

スなどの画面エレメントについての詳しい説明は、RSLinxのコンテキス

ト依存ヘルプを参照してください。ヘルプを参照するための 1つの方法

は、ヘルプを参照したい画面エレメントにカーソルを移動して、F1キー

を押すことです。

デバイスドライバを構成するデバイスドライバを構成するデバイスドライバを構成するデバイスドライバを構成する
デバイスドライバを構成するには、以下を実行します。

1. Startをクリックして、Startメニューで Programs > Rockwell Software 

> RSLinx > RSLinxを選択することにより、RSLinxを開始します。こ

れにより、RSLinxウィンドウが表示されます。

2. RSlinxメニューで Communications > Configure Driversを選択しま

す。これにより、Configure Driversダイアログが表示されます。

3. 構成するドライバを選択して、Add Newをクリックします。これに

より、選択したドライバの構成ダイアログが表示されます。

4. ドライバを構成するには、ドライバの構成パラメータを指定して、

OKをクリックします。これにより、Configure Driversダイアログ が

表示され、構成したドライバが Configured Driversリストに記載され

ます。Closeをクリックします。
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5. RSLinxウィンドウの Communicationsメニューで Super Whoを選択し

ます。これにより、SuperWhoウィンドウが表示されます。データ

ソースとなる PLCプロセッサが SuperWhoウィンドウの図に表示さ

れているかどうかを確認して、SuperWhoウィンドウをクローズしま

す。

DDE トピックを構成するDDE トピックを構成するDDE トピックを構成するDDE トピックを構成する
DDEトピックを構成するには、以下を実行します。

1. RSLinxウィンドウの DDEメニューで Configure Topicを選択します。

これにより、New DDE Topicダイアログが表示されます。

2. 構成するトピック名を編集ボックスに入力して、OKをクリックしま

す。 これにより、DDE Topic Configurationダイアログが表示されます。

3. Update Listをクリックします。 これにより、SuperWhoウィンドウが

再び表示されます。

4. SuperWhoウィンドウで、トピックに対応するプロセッサをダブルク

リックします。これにより、すべてのトピック情報が構成に自動的に

追加されます。DDE Topic Configurationダイアログで、Data Collection 

Mode groupの Unsolicited Message選択ボックスのチェックマークを外

します。OKをクリックすると、トピックが作成され、Topicsダイア

ログが表示されます。

5. Topicsダイアログで Closeをクリックします。これで、DDEを介し

て RSSqlの DDEコントロールコネクションにデータを送信するよう

に、RSlinxが構成されます。
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用語集用語集用語集用語集

DNS 

ドメイン名サーバの略語。ドメイン名サーバは、指定グループ内のすべ

てのコンピュータの名前を含むファイルが格納されているファイルサー

バ。

DSN

データソース名の略語。データソース名は、使用する ODBCデータベー

スの名前です。

RSSql DDEコントロールコネクションコントロールコネクションコントロールコネクションコントロールコネクション

RSSqlトランザクションマネージャと DDEまたは AdvancedDDEサーバ

の間でデータをやり取りするための NTサービス。

RSSql OCIエンタープライズコネクションエンタープライズコネクションエンタープライズコネクションエンタープライズコネクション

RSSqlトランザクションマネージャと Oracle OCI準拠データベースの間

でデータをやり取りするための NTサービス。

RSSql ODBCエンタープライズコネクションエンタープライズコネクションエンタープライズコネクションエンタープライズコネクション 

RSSqlトランザクションマネージャと ODBC準拠データベースの間で

データをやり取りするための NTサービス。

RSSql演算式エディタ演算式エディタ演算式エディタ演算式エディタ

テーブルまたはストアドプロシージャに渡す前にデータを処理するため

のツール。

RSSqlエンタープライズコネクションエンタープライズコネクションエンタープライズコネクションエンタープライズコネクション

RSSqlトランザクションマネージャとデータベースの間でデータをやり取

りするための NTサービス。

RSSql構成構成構成構成 

RSSqlコントロールコネクション、エンタープライズコネクション、およ

びトランザクションに関するユーザ定義パラメータの集まり。
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RSSqlコントロールコネクションコントロールコネクションコントロールコネクションコントロールコネクション

プラント・フロア・デバイスと RSSqlトランザクションマネージャの間

でデータをやり取りするための NTサービス。

RSSqlトランザクションマネージャトランザクションマネージャトランザクションマネージャトランザクションマネージャ

RSSqlコントロールコネクションと RSSqlエンタープライズ・コネク

ション・サービスのブリッジとして機能する NTサービス。

RSView32コントロールコネクションコントロールコネクションコントロールコネクションコントロールコネクション

RSView32で定義したタグを使用して、プラントフロアのデータを RSSql

トランザクションマネージャに移動するための NTサービス。

UNC

汎用命名規則の略語。

アクティベーションファイルアクティベーションファイルアクティベーションファイルアクティベーションファイル

ロックウェル・ソフトウェアのマスタディスク上にあり、1つまたは複数

の製品固有のソフトウェアキーを格納しているファイル。

タグタグタグタグ

あるデータポイントに関する情報の集まり。

トランザクショントランザクショントランザクショントランザクション

トリガイベントによって開始された時に定義済みデータに適用されるア

クションの集まり。

マスタディスクマスタディスクマスタディスクマスタディスク

 Move Activationユーティリティ、Reset Activationユーティリティ、およ

び製品固有のアクティベーションファイルが格納された 3.5インチ・フ

ロッピー・ディスク。アクティベーションファイルには、1つまたは複数

のソフトウェアキーが格納されています。
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